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Disclaimers

Lattice makes no warranty, representation, or guarantee regarding the accuracy of information contained in this document or the suitability of its
products for any particular purpose. All information herein is provided AS IS, with all faults, and all associated risk is the responsibility entirely of the
Buyer. The information provided herein is for informational purposes only and may contain technical inaccuracies or omissions, and may be otherwise
rendered inaccurate for many reasons, and Lattice assumes no obligation to update or otherwise correct or revise this information. Products sold by
Lattice have been subject to limited testing and it is the Buyer's responsibility to independently determine the suitability of any products and to test
and verify the same. LATTICE PRODUCTS AND SERVICES ARE NOT DESIGNED, MANUFACTURED, OR TESTED FOR USE IN LIFE OR SAFETY CRITICAL
SYSTEMS, HAZARDOUS ENVIRONMENTS, OR ANY OTHER ENVIRONMENTS REQUIRING FAIL-SAFE PERFORMANCE, INCLUDING ANY APPLICATION IN
WHICH THE FAILURE OF THE PRODUCT OR SERVICE COULD LEAD TO DEATH, PERSONAL INJURY, SEVERE PROPERTY DAMAGE OR ENVIRONMENTAL
HARM (COLLECTIVELY, "HIGH-RISK USES"). FURTHER, BUYER MUST TAKE PRUDENT STEPS TO PROTECT AGAINST PRODUCT AND SERVICE FAILURES,
INCLUDING PROVIDING APPROPRIATE REDUNDANCIES, FAIL-SAFE FEATURES, AND/OR SHUT-DOWN MECHANISMS. LATTICE EXPRESSLY DISCLAIMS
ANY EXPRESS OR IMPLIED WARRANTY OF FITNESS OF THE PRODUCTS OR SERVICES FOR HIGH-RISK USES. The information provided in this document
is proprietary to Lattice Semiconductor, and Lattice reserves the right to make any changes to the information in this document or to any products at
any time without notice.

Inclusive Language

This document was created consistent with Lattice Semiconductor’s inclusive language policy. In some cases, the language in underlying tools and
other items may not yet have been updated. Please refer to Lattice’s inclusive language FAQ 6878 for a cross reference of terms. Note in some cases
such as register names and state names it has been necessary to continue to utilize older terminology for compatibility.
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Abbreviation Definition

APB Advanced Peripheral Bus

AX14 Advanced eXtensible Interface 4

BL Burst Length

BLTS Bit-Level Trim Sweep

CA Command and Address

CS Chip Select

CBT Command Bus Training

DBI Data Bus Inversion

DDR Double Data Rate

DDRPHY DDR Physical Layer

DFI DDR PHY Interface

DM Data Mask

DQ Data

DQS Data Strobe

ECC Error Correction Code

ECLK Edge Clock

FPGA Field Programmable Gate Array
HPIO High Performance I/O

I/F Interface

JEDEC Joint Electron Device Engineering Council
JTAG Joint Test Action Group

LPDDR4 Low Power Double Data Rate Generation 4
LVSTL Low Voltage Swing Terminated Logic
MC Memory Controller

MR Mode Register

MRS Mode Register Set

oDT On-Die Termination

PRBS Pseudorandom Binary Sequence
PVT Process, Voltage, and Temperature
RTL Register Transfer Level

SCL Self-Calibration Logic

SCLK System Clock

SDR Single Data Rate

SDRAM Synchronous Dynamic Random Access Memory
SSN Simultaneous Switching Noise

TCL Tool Command Language

VREF Voltage Reference
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1. Introduction

The Lattice Semiconductor DDR Memory PHY Module for Avant and Nexus 2 Devices implements the DFI 4.0
Specification (© Cadence Design Systems, Inc.). The DDRPHY IP Module is a hardened block in Lattice Avant and

Nexus 2 devices that describes the interoperation between a Memory Controller and Physical Interface (PHY). The
DDRPHY IP Module provides training and clocking control for the following SDRAM protocols: DDR4 and LPDDR4. The IP
Module is implemented in System Verilog HDL using the Lattice Radiant™ software integrated with the Lattice
Synthesis Engine (LSE) and Synplify Pro® synthesis tools.

1.1. Quick Facts
Table 1.1 presents a summary of the DDRPHY IP Module.

Table 1.1. Quick Facts

DDR4 mode — Lattice Avant, Certus-N2
LPDDR4 mode — Lattice Avant, Certus-N2

For a list of changes to the IP, refer to the DDR Memory PHY IP
Release Notes (FPGA-RN-02072)

Supported Devices

IP Requirements
IP Changes

DFI for PHY access

| f
Supported User Interfaces APB for configuration access

Resource Utilization

Refer to Appendix A. Resource Utilization Table A.1 and

Resources Table A2
Lattice Implementation IP Core v2.6.0 - Lattice Radiant software 2025.1
. Lattice Synthesis Engine
X Synthesis . .
Design Tool Support Synopsys® Synplify Pro for Lattice
. . For a list of supported simulators, refer to the Lattice Radiant
Simulation

Software User Guide

1.2. Features
The DDRPHY IP Module supports the following key features for DDR4 and LPDDR4 SDRAM.

1.2.1. DDR4
The DDRPHY Module, when configured in DDR4 mode, supports the following key features for Avant and Nexus 2
devices:
e DDR4 SDRAM protocol, compliant to DDR4 JEDEC Standard
e DDR4 SDRAM speeds ranging from 350 MHz to 1,200 MHz (700 Mbps to 2,400 Mbps)
e Memory Interface features:
e |nterface data widths of x16, x32, and x64
e Interface data widths of x40 and x72 are also supported when Sideband ECC is enabled
e x8and x16 DDR4 device support (8:1 DQ:DQS ratio)
e  Configurable CAS latencies for Reads and Writes based on target interface speed
e 8:1gearing mode (4:1 DDR4-to-FPGA clock frequency ratio)
e  Supports component (DRAM soldered on the board) and UDIMM
e  Memory Training features:
e Automatic DDR4 initialization
e Write Leveling
e Read Training
e  Write Training
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Self-Calibrating Logic
Bit-Level Trim Sweep

Includes dedicated PLL for clock generation

Table 1.2. DDR4 Features Overview
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Key Features

DDR4 Support Details

Device Format

Component, DIMM not yet supported

Data Widths

x16, x32, x40, x64, x72

PHY Interface

DFI

Configuration Interface

APB

Maximum Data Rate

Refer to Table 1.6 and Table 1.7

Other Features!

Error Correction Code (ECC)

Yes

Dual-rank

Yes

Data Bus Inversion (DBI)

Not yet supported, for reads, No for writes

On-Die Termination (ODT)

Yes, for DQ, No for CA

Training?

Initialization Yes

CS Training Not yet supported
Write Leveling Yes

Read Training Yes

Write Training Yes

Automatic VREF Training Not yet supported
Self-Calibrating Logic Yes

Bit-Level Trim Sweep Not yet supported

Note:

1.

1.2.2. LPDDR4
The DDRPHY Module, when configured in LPDDR4 mode, supports the following key features for Avant and Nexus 2

Devices:

Yes implies that a configurable option exists to enable or disable the feature. No implies that the feature is currently not
supported and will not be supported in the future.

LPDDR4 SDRAM protocol, compliant to LPDDR4 JEDEC Standard
LPDDR4 SDRAM speeds ranging from 350 MHz to 1,200 MHz (700 Mbps to 2,400 Mbps)
Memory Interface features:

Interface data widths of x16, x32, and x64

8:1 gearing mode (4:1 LPDDR4-to-FPGA clock frequency ratio)
Memory Training features:

Automatic LPDDR4 initialization
Command Bus Training

Write Leveling

Read Training

Write Training

VREF Training

Self-Calibrating Logic

Bit-Level Trim Sweep

Includes internal programmable VREF
Includes dedicated PLL for clock generation
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Table 1.3. LPDDR4 Features Overview
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Key Features

LPDDR4 Support Details

Device Format Component
Data Widths x16, x32, x64
PHY Interface DFI
Configuration Interface APB

Maximum Data Rate

Refer to Table 1.6 and Table 1.7

Other Features!

Dual-rank

Yes

Data Bus Inversion (DBI)

Yes, for reads, No for writes

On-Die Termination (ODT)

Yes for DQ and CA

Training?

Initialization Yes
Command Bus Training Yes
Write Leveling Yes
Read Training Yes
Write Training Yes
Automatic VREF Training Yes
Self-Calibrating Logic Yes
Bit-Level Trim Sweep Yes

Note:

1. Yesimplies that a configurable option exists to enable or disable the feature. No implies that the feature is currently not

supported and will not be supported in the future.

1.3. IP Validation Summary

The DDRPHY IP Module supports Avant-AT-E, Avant-AT-G, Avant-AT-X, and Nexus 2 devices. Table 1.4 and Table 1.5
summarize the compilation, simulation, and hardware validation for the DDRPHY IP.

Table 1.4. Avant IP Validation Summary

Device/Mode Compilation Simulation Hardware

DDR4

Avant-AT-E Yes Yes No

Avant-AT-G Yes Yes No

Avant-AT-X Yes Yes No

LPDDR4

Avant-AT-E Yes Yes Yest3

Avant-AT-G Yes Yes Yest 23

Avant-AT-X Yes Yes Yest 23
Notes:

1. Supports x16 and x32 data widths only. The data width of x64 is not hardware validated.
2.  Supports up to 1,066 MHz only. 1,200 MHz is not yet hardware validated.
3. Supports single rank only. Dual rank is not yet hardware validated.
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Table 1.5. Nexus 2 IP Validation Summary

Device/Mode? | Compilation | Simulation | Hardware
DDR4
Nexus 2 ‘ Yes ‘ Yes ‘ No
LPDDR4
Nexus 2 ‘ Yes I Yes I No
Note:

1. Nexus 2 supports only DDR4 and LPDDR4 interfaces.

1.4. Licensing and Ordering Information
The DDRPHY IP is provided at no additional cost with the Lattice Radiant software.

1.5. Minimum Device Requirements

The DDRPHY IP Module supports Avant E/G/X and Nexus 2 devices. Table 1.6 and Table 1.7 summarize the minimum
device requirements for the DDRPHY IP Module.

Table 1.6. Avant Minimum Device Requirements

Device/Mode | DDR Data Width | DDR Ranks Maximum Interface Speed | Supported Speed Grades

DDR4
Avant-AT-E/G/X x16, x32, x40, x64, x72 1 933 MHz (1,866 Mbps) 1,23
Avant-AT-E/G/X x16, x32, x40, x64, x72 1,2 1,066 MHz (2,133 Mbps) 2,3
Avant-AT-E/G/X x16, x32, x40, x64, x72 1 1,200 MHz (2,400 Mbps) 3

LPDDR4
Avant-AT-E/G/X x16, x32, x40, x64, x72 1 933 MHz (1,866 Mbps) 1,2,3
Avant-AT-E/G/X x16, x32, x40, x64, x72 1,2 1,066 MHz (2,133 Mbps) 2,3
Avant-AT-E/G/X x16, x32, x40, x64, x72 1 1,200 MHz (2,400 Mbps) 3

Table 1.7. Nexus 2 Minimum Device Requirements

Device/Mode DDR Data Width DDR Ranks Maximum Interface Speed | Supported Speed Grades
DDR4

Nexus 2 x16, x32, x40 1 933 MHz (1,866 Mbps) 1,2,3

Nexus 2 x16, x32, x40 1,2 1,066 MHz (2,133 Mbps) 2,3

Nexus 2 x16, x32, x40 1 1,200 MHz (2,400 Mbps) 3
LPDDR4

Nexus 2 x16, x32, x40 1 933 MHz (1,866 Mbps) 1,2,3

Nexus 2 x16, x32, x40 1,2 1066 MHz (2,133 Mbps) 2,3

Nexus 2 x16, x32, x40 1 1200 MHz (2,400 Mbps) 3
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1.6. Naming Conventions

This section provides information regarding terminology used within this document.

1.6.1. Nomenclature
The nomenclature used in this document is based on Verilog HDL.

1.6.2. Signal Names

Signal Names that end with:

e _nare active low

e _jareinput signals

e _oareoutputsignals

e _joare bi-directional input/output signals

© 2023-2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice
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2. Functional Description

This section provides a detailed functional description of the DDRPHY IP Module, including information regarding clock
and reset handling, available user data and configuration interfaces, the calibration sequence, and operation
descriptions.

2.1. IP Architecture

The DDRPHY Module consists of three main blocks: the DDRPHY Software Primitive, the DDRPHY Hard IP, and the
Training Engine. Figure 2.1 shows the DDRPHY Module sub-blocks and their connectivity.

_
DDRPHY Module |

o Training Engine |

o0

o " - APB Bridge/

g Configuration Interface > Interconngect o o

3 CSR |

k J
PLL [ Quarter Rate I
L Clock Generator

— DDRPHY Software Primitive | ]
o]

3 ; Y

5

3 Y 2
> DF14.0 PHY Interface . Memory Interface P
S Gearing [a)
€ Full/Half Rate p| Ccomverter | g p|  OORPHY <
= Clock Generator And Hard IP

CDC FIFO

Figure 2.1. DDRPHY IP Module Functional Diagram

The configuration interface provides access to the Training Engine and the Configuration Set Registers (CSRs), which
configure the DDRPHY and perform the DDR4 and LPDDR4 training sequences. The PHY interface allows users to
initiate command, address, control, and read/write operations via a memory controller to the external DDR4/LPDDR4
SDRAM. The memory interface enables the selected Lattice FPGA to communicate with the external DDR4/LPDDR4
memory. For more information on the PHY and configuration interfaces, refer to the User Interfaces section of this
User Guide.

2.1.1. Hardened DDRPHY Software Primitive

The Hardened DDRPHY consists of the following submodules:
e  Full/Half Rate Clock Generator

e  Gearing Converter and CDC FIFO

e DDRPHY Hard IP
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2.1.1.1. Full/Half Rate Clock Generator

The DDRPHY Software Primitive contains a full-rate and half-rate clock generator, which utilizes dedicated PLLs and
clock routing to enable high-frequency operation. The PLL provides a full-rate clock (ECLK) to the Hard IP and the
half-rate clock (SCLK) to the Hard IP, and Gearing Converter, and CDC FIFO.

2.1.1.2. Gearing Converter and Clock Domain Crossing FIFO

The DDRPHY Hard IP implements a frequency ratio of 1:2 (4:1 gearing). The gearing converter and CDC FIFO convert
this to a frequency ratio of 1:4 (8:1 gearing). The gearing converter implements 2:1 and 1:2 gearing to allow DFI signals
to run at half-rate. The CDC FIFO ensures signal integrity when transferring data to and from FPGA fabric.

2.1.2. Hardened DDRPHY IP

The DDRPHY Hard IP implements the DFI 4.0 Standard. It connects to High Performance 1/0O (HPI0O) to support high-
frequency operation and allow reuse of FPGA I/O for other functions when the DDRPHY Hard IP is not utilizing the I/0.
The DDRPHY Hard IP translates the PHY interface signals (DFI) from the fabric to memory interface signals for
DDR4/LPDDR4 SDRAM.

2.1.3. Soft Training Engine

The Training Engine reads instructions from system memory and initializes and trains the external DDR4/LPDDR4
memory. It achieves this by accessing the Configuration Set Registers of the DDRPHY Module, PLL, and DDRPHY Hard IP.
You issue commands to the Training Engine to perform reads and writes to these registers, allowing them to handle
interrupts and obtain details during the memory training sequence.

2.2. Clocking

The DDRPHY IP Module, when configured for DDR4 and LPDDR4 interfaces, requires a differential input reference clock:
pll_refclk_i. You need to provide this clock via an external source, an internal oscillator, or a dedicated PLL. This clock
routes through a dedicated PLL within the DDRPHY IP to generate the Edge Clock (ECLK) and System Clock (SCLK). The
ECLK signal clocks the I/O modules internally within the IP Core, and SCLK clocks the IP Core. The Primary Clock (PCLK)
signal implements clock synchronization logic to synchronize SCLK and ECLK.

The DFl interface for the DDRPHY Module operates off the sclk_o signal and resets via the dfi_reset_n_i signal. The
configuration interface for the DDRPHY IP Module operates off the pclk_i signal and resets via the preset_n_i signal.
The clock for the configuration interface is the same one that implements clock synchronization for SCLK and ECLK.
Refer to the Clock and Reset Signal Description section of this user guide for information regarding the clocks and
resets for DDR4 and LPDDR4 memory interfaces.

2.3. Reset

The DDRPHY IP Module contains an asynchronous active high reset: rst_i. This signal requires a minimum pulse width of
2x the pclk_i period. When asserted, the external SDRAM resets to its default value. The DDRPHY Module contains
internal logic that synchronously de-asserts the internal reset once rst_i is de-asserted, so you do not need to worry
about implementing their own deassertion logic.

The preset_n_i signal is an asynchronous active low reset, which you must ensure is synchronously de-asserted to
pclk_i. Refer to the Clock and Reset Signal Description section of this user guide for information regarding the clocks
and resets for DDR4 and LPDDR4 memory interfaces.
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2.4. User Interfaces

This section describes the supported protocols for data and configuration interfaces available to the user and
supported by a DDR4/LPDDR4 Memory Controller.

2.4.1. DFI 4.0 PHY Interface

The DFI 4.0 I/F defines how control and data information communicate between a memory controller and PHY. For
more information regarding the DFI 4.0 Interface, refer to the DFI 4.0 Specification. The DFI I/F operates off the sclk_o
signal and resets via the dfi_reset_n_i signal. Refer to the Clock and Reset Signal Description section of this user guide
for more details. For additional information on the available user DFI signals, refer to the DFI 4.0 Interface Signal
Description section and the Operation Descriptions section of this user guide.

2.4.2. APB Configuration Interface

The configuration interface allows users to initialize and train the memory interface. The APB I/F is a low-power
protocol intended for accessing programmable control registers. It is not pipelined and is a synchronous protocol with a
single address bus and two data buses: write and read. The DDRPHY does not support APB write strobe commands. For
more information regarding the APB protocol, refer to the AMBA APB Protocol Specification.

The DDRPHY IP Module leverages this protocol to initialize and train the interface between FPGA logic and external
SDRAM. The APB I/F operates off the pclk_i signal and resets via the preset_n_i signal. Refer to the Clock and Reset
Signal Description section of this user guide for more details.

2.5. Calibration

To ensure proper device functionality, you must initialize and train the external memory. The DDRPHY Module consists
of a soft RISC-V CPU located inside the Training Engine that executes the initialization and training routines for DDR4
and LPDDRA4. Table 2.1 summarizes the calibration or training stages supported for each memory protocol by the
DDRPHY IP.

Table 2.1. Calibration Summary

Command Bus Write Read Write VREF Self-Calibrating Bit-Level Trim
Training Leveling Training Training Training Logic Sweep
DDR4 No Yes Yes Yes Yes Yes Not Yet
Supported
LPDDR4 Yes Yes Yes Yes Yes Yes Yes

To start the initialization and training sequence for the SDRAM device, you should execute the following steps via the

configuration interface:

1. Ensure that the DDRPHY Module’s PLL is in the lock state by polling the PHY Clock Register (PHY_CLOCK) until the
pll_lock signal asserts (PHY_CLOCK[1]=1).

2. Enable initialization and training by writing 10’h3DF to the Training Operation Register (TRN_OP_REG) for interfaces
for high-speed applications running at 1,066 MHz to 12,00MHz (2,133 Mbps to 2,400 Mbps). Otherwise, write
10’hODF to TRN_OP_REG. This enables the appropriate training sequences depending on the SDRAM standard. For
simulation purposes, shorten the initialization and training sequences by writing 10’h01C to TRN_OP_REG. For
more information, refer to the Register Description section of this user guide.

3. Pull the CPU and Training Engine out of reset by writing 1’b1 to the Reset Register (RESET_REG). This begins the
initialization and training sequence.

4. Wait until initialization and training completes using one of the following methods:

e  Poll the Status Register (TRN_STATUS_REG) until the bit_Ivl_trim_sweep_done signal asserts
(TRN_STATUS_REG[16]=1). This indicates that the bit-level trim sweep has completed, which is the final stage
in the initialization and training process.
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e  Wait for the trn_done_int signal (INT_STATUS_REG[0]=1) or the trn_error_int signal (INT_STATUS_REG[1]=1) to
assert in the Interrupt Status Register (INT_STATUS_REG). This method requires the trn_done_en signal
(INT_ENABLE_REG[0]=1) and the trn_err_en signal (INT_ENABLE_REG[1]=1) to be asserted in the Interrupt
Enable Register (INT_ENABLE_REG).

After completing the above steps, the DDRPHY Module is ready for DFI access. Once init_done_o asserts, the RISC-V
CPU and Training Engine enter reset to save power.

2.5.1. Command Bus Training (CBT)

The goal of Command Bus Training (CBT) is to delay the command and address signals as necessary to optimize the CA
window. When setting the cbt_en signal high (TRN_OP_REG[1]=1), the Memory Controller performs CBT according to
the DDR4 JEDEC Standard and LPDDR4 JEDEC Standard. This centers the entire CA bus relative to ddr_ck_o by aligning
the rising edge of CK to the middle of the CA valid window. The DDR4/LPDDR4 memory then provides feedback to user
through the DQ line, which the Memory Controller uses to determine if additional adjustment is required.

During this time, the DDR clock, ddr_ck_o, stops before and after CBT. This is expected as the clock is switches between
low frequency (50 MHz) and high frequency (LPDDR4 interface speed) operation, as outlined in the DDR4 JEDEC
Standard and LPDDR4 JEDEC Standard. Upon successful completion of CBT, ddr_ca_o centers to the eye of ddr_ck_o,
ensuring correct behavior during high frequency operation.

ddr ck [ f§ | ddr_ck f | f |
ddr_ca[0] M@W ddr_ca[0] | 2
ddr_ca[l] 777777 ddr_ca[1] Z
st i e — /
Effective Window Effective Window

Figure 2.2. Command Bus Training

2.5.2. Write Leveling

The purpose of write leveling is to delay each Data Strobe (DQS) relative to the DDR clock during write operations so
they are edge-aligned. This addresses the CK to DQS timing skew introduced with the adoption of Fly-By Topology,
which reduces Simultaneous Switching Noise (SSN) by allowing different memory components to receive write
commands at different times. Setting the write_Ivl_en signal high (TRN_OP_REG[2]=1) enables write leveling on all
available ranks. During this process, the ddr_dqs_o signal is delays until a 0-to-1 transition on ddr_ck_o is captured by
the dgs rising edge of the SDRAM device. The SDRAM memory then provides feedback of the captured clock signal
value through the DQ line to determine if additional adjustment is required.
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Source (FPGA) 0 1 . 3

ddr_ck f f f f
ddr_dgs f +

Destination (SDRAM)
Before write leveling TO T1 T2 T3
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ddr_dgs f {
ddr_dg X 0 X 0
—>» i1« Skew: DQS arrives slightly before CK

Destination (SDRAM)
After write leveling o T1 T 3

drek _ F L& L& & 1_
ddr_dgs ! +

ddr_dq ! 1 X 1
Deskew: DQS aligned with CK

Figure 2.3. Write Leveling

2.5.3. Read Training (Read Bit-Leveling)

The purpose of read training, or read DQ-bit leveling, is to center-align DQS relative to the DQ window. Setting the
read_trn_en signal high (TRN_OP_REG[3]=1), enables read training. This compensates for unpredictable delays on DQ
which can lead to skew between each input DQ and its respective DQS. During this process, a continuous 1-0-1-0
pattern is read from SDRAM on DQ, where DQS is delayed by 90 degrees. The DQ is then delayed and advanced to
capture both edges of ddr_dq_io reading a 0, resulting in the DQ valid window. This indicates how far/close the rising
edge of ddr_dgs_io is from ddr_dq_io to determine the amount of delay/advancement needed to align the rising edge
of ddr_dqgs_io to the ddr_dq_io valid window.

Before read-bit leveling (FPGA)

ddr_das N B T R R D
ddr_dq[0] 7 A 1 o ¥

i DQJ[0] window is not center-aligned to DQS edge
> '€
% ! (Delay DQ[O] to get left-edge)

ddr_das oo L4 L4 L+ [t
ddr_da[o] 7 S S SN SR NN

> é DQ[0] window is not center-aligned to DQS edge
: é (Advance DQ[O] to get right-edge)

After read-bit leveling (FPGA)

ddr_dgs N T T O B T I
ddr_dq[0] 7 }{ ; }{ 1 X o ¥

> DQ[0] window is centered to DQS edge
: H (Delay DQJO] to middle of valid window)

Figure 2.4. Read DQ-Bit Leveling
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The purpose of write training, or write DQ-bit leveling, is to center-align DQS relative to the DQ window. Setting the
write_trn_en signal high (TRN_OP_REG[4]=1) enables write training. To achieve alighment, you must write a
continuous 1-0-1-0 pattern to SDRAM and read it back to ensure successful writes. During this process, DQ delays and
advances to capture both edges of ddr_dq_io successfully writing a 0, resulting in the DQ valid window. This indicates
how far/close the rising edge of ddr_dqgs_io is from ddr_dq_io to determine the amount of delay/advancement needed
to align the rising edge of ddr_dqgs_io to the ddr_dq_io valid window.

2.5.5.

Before write-bit leveling (FPGA)

ddr_dgs ‘f + | |

ddr_dq[O]%{ 0 J 1 0o |

2D GECEED G

=

—>

DQ[0] window is not center-aligned to DQS edge
(Delay DQ[0] to get left-edge)

ddr_dgs

ddr_dq[0] %{ 0

D G SN

0 %}4&

i

After read-bit leveling (FPGA)

DQ[0] window is not center-aligned to DQS edge
(Advance DQJO] to get right-edge)

N T S

ddr_dqgs + + | |
ddrdafo] ¥ o ¥ 1 ¥ o ¥ 1 ¥ o ¥ 1 ¥
4»5 | ; DQ[0] window is centered to DQS edge
i | f (Delay DQ[0] to middle of valid window)
Figure 2.5. Write DQ-Bit Leveling
VREF Training

The goal of VREF training is to provide stable and robust memory access by maximizing margins on command, address,

chip select, and data signals. VREF training occurs as part of CBT, read training, and write training. Setting the

ca_vref_training_en (TRN_OP_REG[5]=1), mc_vref_training_en (TRN_OP_REG[6]=1), and mem_vref_training_en

(TRN_OP_REGJ[7]=1) signals high enables VREF training during CBT, reading training, and write training.

The voltage reference decides if a signal is registered as high (1) or low (0). Due to PVT variations and ODT

drive/impedance matching, the internal voltage reference on DDR4/LPDDR4 can fluctuate, causing the center of the
eye to move. VREF training consists of repeating the CBT, read training, and write training steps across different VREF
values to find the center of the vertical valid window to maximize margins during operation.
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Figure 2.6. VREF Training

2.5.6. Self-Calibrating Logic (SCL)

The purpose of self-calibrating logic is to eliminate any DDR timing issues during DDR4/LPDDR4 read and write
operations by performing the following:

e  Clock Domain Crossing (CDC)
e Latency Calibration

The goal of SCL CDC is to ensure sufficient margins during read operations by finding the center between the rising
edge of ddr_ck_o and the falling edge of the next input ddr_dqs_io. This is achieved by performing 2 writes to SDRAM
and then continuously reading data back while performing internal delay adjustments. Figure 2.7 shows the circuit for
implementing the read capture logic, where the data_capture_clk is the variable delay clock, which SCL tunes to
optimize setup and hold margins when clocking data from the input SDRAM DQS domain (ddr_dgs_io) to the DDRPHY
clock domain represented as full_rate_clk.

g8 ddr_dqg_io

A

d1_rd_datal rd_datal

<O<—‘ << 8
16
dfi_rddata_o <_|74 concat
<

rd_data_captured rd_data2

A

A

A

ddr_dgs_io

< < <P+

full_rate_clk data_capture_clk

Figure 2.7. Self-Calibrating Logic CDC Training Circuit
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During the SCL routine, the DDRPHY searches for the falling edge of input DQS. Once found, the valid data following the
DQS falling edge is captured in the rd_data_captured register and held for clocking into the PHY clock domain. SCL finds
the center between the rising edge of the full_rate_clk and the falling edge of the next input DQS strobe, shown by
points A and B in Figure 2.8. The point that gives the largest setup and hold margins (point B) is set as the active edge
location for the captured read data.

aer_ds Jo + S e S e S
ddr_dq_io Z ¥ ¥ 1 Y77
full_rate_clk 4+—| | +—|—+—|—+—|_

»
>

A B

>
L]

A

Figure 2.8. Self-Calibrating Logic CDC Timing Diagram
In the latency calibration stage, you determine the best clock phase to capture the incoming data. The captured data
from the rd_data_captured register is passed into the circuit shown in Figure 2.9, where SCL incrementally adjusts the

multiplexer select signal (main_clk_delta_dly) until the proper data (dfi_rddata_o) is received relative to full_rate_clk.

main_clk_delta_dly

A 24 4

dfi_rddata_o

rd_data_captured

< < < < < < <
‘—‘ ‘—‘ ‘—‘ ‘—‘ full_rate_clk

Figure 2.9. Self-Calibrating Logic Latency Training

2.5.7. Bit-Level Trim Sweep (BLTS)

The purpose of bit-level trim sweep is to ensure proper alignment and sampling of the rising edge of DQS relative to DQ
during DDR4/LPDDR4 write and read operations. Bit-level trim sweep helps to account for system SI/PI related
variations/jitter introduced for high-speed applications running at 933 MHz — 1,200 MHz (1,866 Mbps — 2,400 Mbps).
Setting the bit_Ivl_trim_sweep_en (TRN_OP_REG[8]=1) signal high enables bit-level trim sweep.

Bit-level trim sweep is similar to read bit-leveling and write bit-leveling training stages. However, it helps to calibrate
the DQS-DQ timing for complex and random transitions, compared to the simple 1-0-1-0 pattern completed in read
bit-leveling and write bit-leveling training stages. Run bit-level trim sweep after SCL for frequencies greater than 800
MHz.
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2.6. Operation Descriptions

The DFI4.0 specifies several interfaces for training specific signals. The DDRPHY Module does not require these signals

as it operates independently to fully perform the calibration sequence.

Note these special connectivity requirements:

e The dfi_rddata_en_pO_i and dfi_rddata_en_p2_i signals may be provided as a per byte lane output from the
controller, with all bits having identical timing. The PHY requires only one dfi_rddata_en input. Connect the LSB
(bit 0) of the controller’s dfi_rddata_en to PHY dfi_rddata_en. The same connection applies to dfi_wrdata_en_p0_i
and dfi_wrdata_en_p2_i.

e The turn_off_addr_ctrl_drv_i signal is a special PHY input that the memory controller can use to dynamically turn
off the DRAM clock and command/address outputs during self-refresh to save power. If the controller does not
support this feature, you can turn off the DRAM clock and command/address outputs using a software-
programmable register bit if required. During memory initialization, the DDRPHY module asserts the
turn_off_addr_ctrl_drv_i signal internally to turn off these DRAM clock and command/address outputs during
reset and CKE wait periods.

When controlling the timing of the turn_off_addr_ctrl_drv_i assertion (logic 1) after issuing a self-refresh entry
command on the DFI bus via a memory controller, follow the JEDEC spec for clock shut off after entering self-refresh
mode. Add an additional 5 sclk_o margin to ensure that the DFI command propagation through the PHY is satisfied
before the assertion.

When de-asserting turn_off_addr_ctrl_drv_i (logic 0) before issuing a self-refresh exit command, you need an
additional 5 sclk_o margin to ensure that turn_off_addr_ctrl_drv_i propagates to the I/Os and the clock output turns
on and stabilizes before issuing the self-refresh exit command on the DFI bus.
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The following tables show and describe the configurable attributes of the DDRPHY IP Module. You can configure these
attributes through the IP Catalog’s Module/IP Block Wizard of the Lattice Radiant software. Refer to the Designing and
Simulating the IP section of this user guide for information on how to configure and generate the DDRPHY Module.

3.1. DDRA4 Parameters

This section describes the parameters available in the General and Training Settings tabs of the IP parameter editor for

DDR4 interfaces.

3.1.1. DDR4 General

Table 3.1. DDR4 General Attributes

(MHz)

Attribute Selectable Values Default Dependency on Other Attributes
Interface Type DDR4 — —
I/0 Buffer Type POD12 POD12 Display only
Gearing Ratio 8:1 8:1 Display only
Enable Side-Band ECC Checked, Unchecked Unchecked —
10 10 DDR Memory Frequency = 666 MHz
10, 11, 12 12 DDR Memory Frequency = 800 MHz
Read Latency 12,13,14 12 DDR Memory Frequency = 933 MHz
14, 15, 16 14 DDR Memory Frequency = 1,066 MHz
15, 16,17, 18 16 DDR Memory Frequency = 1,200 MHz
9 DDR Memory Frequency = 666 MHz
9,11 DDR Memory Frequency = 800 MHz
Write Latency 10, 12 10 DDR Memory Frequency = 933 MHz
11,14 11 DDR Memory Frequency = 1,066 MHz
12,16 12 DDR Memory Frequency = 1,200 MHz
Data Bus Width 16,32, 64 32 — -
40, 72 — If Enable Sideband ECC == Checked
Display only
Enable Training CPU Checked Checked Disabling the Internal RISC-V CPU is not yet
supported.
Table 3.2. DDR4 Clock Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
Enable PLL Checked Checked Display only
DDR Memory Frequency (MHz) 666, 800, 933, 1066, 1200 | 800 —_
Display only
System Clock Frequency (MHz) Calculated N/A Calculated based on the selection for DDR
Memory Frequency.
Reference Clock Frequency (MHz) 10-800 100 —
DDR Memory Actual Frequency Calculated N/A g;SsF:ZyozTge selection for DDR Memory

Frequency.
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Table 3.3. DDR4 Clock/Address/Command Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Number of Clocks 1,2 1 —

Number of Chip Selects (Rank) 1,2 1 —

Address Width 14 14 Display only

Number of Chip ODT 12 1 SB:Iseecc:;n the selection for Number of Chip
BA Width Display only

BG Width Display only

Table 3.4. DDR4 General Definitions

Attribute

| Description

General Group

DDR Interface Type

Specifies the SDRAM Memory interface: DDR4.

I/0 Buffer Type

I/0 Standard for the memory interface signals.
This is fixed to POD12 for DDR4 but the command/address/control signals should be
terminated to VTT on the board. Please see note 2 of Table 4.5.

Gearing Ratio

Specifies the ratio relationship between the DDR data speed and the memory controller
speed.

Enable Sideband ECC

Enables error-correction code (ECC) for single-bit error correction and double-bit error
detection.

Enable DBI

Enables data bus inversion (DBI) for better signal integrity and read/write margins.

Read Latency

Specifies the delay from issuing a read command to receiving of read data from SDRAM.
Set this based on the target DRAM’s datasheet.

Write Latency

Specifies the delay from issuing a write command to providing of write data to SDRAM.
Set this based on the target DRAM’s datasheet.

Data Bus Width

Specifies the total number of data pins in the memory interface.

Enable Training CPU

Enables RISC-V subsystem to support initialization and training of the memory device.
Disabling is not yet supported.

Clock Settings Group

Enable PLL

Enables PLL

DDR Memory Frequency (MHz)

Speed at which the memory controller issues commands to the memory device.

System Clock Frequency (MHz)

Speed to clock the memory controller.

Reference Clock Frequency (MHz)

Indicates the PLL reference clock speed.

DDR Command Actual Frequency
(MHz)

Specifies the actual operating frequency of the memory interface (calculated by the PLL —
includes tolerance)

Clock/Address/Command Group

Number of DDR Clocks

Specifies the number of CK/CK# clock pairs to be driven to the SDRAM.

Number of Chip Selects

Specifies the number of Chip Select (CS) signals to be driven to SDRAM.

Address Width Specifies number of address pins in memory interface, dependent on the SDRAM density.
Number of Chip ODT Specifies the number of ODT bits.

BA Width Specifies the row and column address of SDRAM.

BG Width Specifies the bank group address of SDRAM.
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Attribute Selectable Values Default Dependency on Other Attributes
DDR Clock Delay Value 0-20 15 —
DDR Clock Delay Value Incr/Decr Checked/Unchecked Checked —
CS Delay Value 0-20 15 —
CS Delay Value Incr/Decr Checked/Unchecked Checked —
Address Control Delay Value 0-20 4 —
,IAndccri;gseschIock Delay Value Checked/Unchecked Unchecked —
Memory DQ_Vref Value for Rank0 | 0-114 25 —
Memory DQ_Vref Value for Rankl | 0-114 25 Enabled when Number of Ranks==2
MC DQS Grp<0,1> Vref Value 0-127 80 —
MC DQS Grp<2,3> Vref Value 0-127 80 Enabled when DDR Bus Width>=32
MC DQS Grp<4,7> Vref Value 0-127 80 Enabled when DDR Bus Width>=64
Table 3.6. DDR4 PHY 1/0 Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
CK/CS Slew Rate Slow, Fast Fast —
Command Address Slew Rate Slow, Fast Fast —
DQS Slew Rate Slow, Fast Fast —
DQ/DMI Slew Rate Slow, Fast Fast -
2400, 1200, 68 Q, 60 Q,
MC CA Output Impedance 480,400,340 340 -
2400,1200,68 Q, 60 Q,
MC DQ Output Impedance 480,400,340 34 Q -
2400, 1200, 68 Q, 60 Q,
MC ODT Value 480,400,340 60 Q —
Table 3.7. DDR4 Memory ODT Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
Dynamic ODT OFF, RzQ/1 Dynami
RTT_WR Value R;sz, (F:{ZOQ/3,OHi-IZ v oFF T -
Disable, RZQ/1, RzQ/2,
RTT_NOM Value RzQ/3, RzQ/4, RZQ/5, RzQ/5 -
RzZQ/6, RZQ/7
Disable, RZQ/1, RZQ/2,
RTT_PARK Value RzQ/3, RzQ/4, RZQ/5, Disable —

RzQ/6, RZQ/7

Table 3.8. DDR4 Training Settings Definitions

Attribute?

| Description

Training Settings Group

DDR Clock Delay Value

Specifies the DDR clock delay so that the first DQS toggle is at CK = 0 during write leveling.
It is recommended to increase this value if write leveling fails.

DDR Clock Delay Value Incr/Decr

Specifies the adjustment direction.
Checked: DDR Clock Delay Value is added to the ddr_ck_o signal.
Unchecked: DDR Clock Delay Value is subtracted from the ddr_ck_o signal.

CS Delay Value

Specifies the DDR CS delay value.
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Attribute?

Description

CS Delay Value Incr/Decr

Specifies the adjustment direction.
Checked: CS Delay Value is added to the ddr_cs_o signal.
Unchecked: CS Delay Value is subtracted from the ddr_cs_o signal.

Address Control Delay Value

Specifies the DDR address/control signals delay. It is recommended to increase this value if
the command bus training fails.

Address Clock Delay Value
Incr/Decr

Specifies the adjustment direction.

Checked: Address Control Delay Value is added to the DDR address/control signals.
Unchecked: Address Control Delay Value is subtracted from the DDR address/control
signals.

Memory DQ_Vref Value for
Rank<0,1>

Specifies the DRAM DQ_Vref Value to be written to the DDR4 MR6 VR(DQ) and VREF(DQ)
for RankO/Rank1. When the register field TRN_OP_REG.mem_vref_training_en=0, this will
be used as the final DRAM DQ Vref.

MC DQS Grp<0,1> Vref Value

Specifies the MC DQ_Vref Value for each DQS group when DQ_Vref training is disabled by
setting TRN_OP_REG.mc_vref_training_en=0.
The theoretical mV value is: Vref decimal value x 5 mV.

DDR4 MC I/0 Settings

CK/CS Slew Rate

Specifies the CK/CS driver strength.

Command Address Slew Rate

Specifies the CA driver strength.

DQS Slew Rate

Specifies the DQS driver strength.

DQ/DMI Slew Rate

Specifies the DQ/DMI driver strength.

MC CA Output Impedance

Memory controller CA I/O impedance to reach VDDQ threshold.

MC DQ Output Impedance

Memory controller DQ I/O impedance to reach VDDQ threshold.

MC ODT Value Memory controller termination resistance value at FPGA.
DDR4 Memory ODT Settings
RTT_WR Value Specifies the RTT_WR value that is written to MR2 in DDR4 memory.

RTT_NOM Value

Specifies the RTT_NOM value that is written to MR1 in DDR4 memory.

RTT_PARK Value

Specifies the RTT_PARK value that is written to MR5 in DDR4 memory.

Note:

1. Modify these attributes only when you encounter an error during DDR4 memory training. Use them only when skipping DDR4
training during simulation. You can also skip training on hardware when set correctly, but this is not recommended as the
delays and VREFs will not adjust according to environmental temperature variations.

3.2. LPDDR4 Parameters

This section describes the parameters available in the General and Training Settings tabs of the IP parameter editor for

LPDDR4 interfaces.

3.2.1. LPDDR4 General

Table 3.9. LPDDR4 General Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Interface Type LPDDR4 — —

I/O Buffer Type LVSTL11 I, LVSTL11_II LVSTL11 | —

Gearing Ratio 8:1 8:1 Display only

Enable Sideband ECC Checked, Unchecked Unchecked ?(I.‘S(_?l'?llvg:tlet supported.

Enable Read DBI Checked, Unchecked Unchecked -
Display only

Read Latency Calculated N/A Calculated based on the selection for DDR
Memory Frequency.
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Attribute Selectable Values Default Dependency on Other Attributes
Display only

Write Latency Calculated N/A Calculated based on the selection for DDR
Memory Frequency.

Data Bus Width 16, 32, 64 32 —
Display only

Enable Training CPU Checked Checked Disabling the Internal RISC-V CPU is not yet
supported.

Table 3.10. LPDDR4 Clock Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
Enable PLL Checked Checked Display only
350, 400, 533, 666, 800,

DDR Memory Frequency (MHz) 933, 1066, 1200 933 —
Display only

System Clock Frequency (MHz) Calculated N/A Calculated based on the selection for DDR
Memory Frequency.

Reference Clock Frequency (MHz) 25, 50, 100 100 —
Display onl

I()I\Izgzl;llemory Actual Frequency Calculated N/A BasF:adt)n tf\:e selection for DDR Memory
Frequency.

Table 3.11. LPDDR4 Clock/Address/Command Attributes

Attribute Selectable Values Default Dependency on Other Attributes

Number of Clocks 1,2 1 —

Number of Chip Selects (Rank) 1,2 1 —

Address Width 14 14 Display only

Table 3.12. LPDDR4 General Definitions

Attribute

| Description

General Group

DDR Interface Type

Specifies the SDRAM Memory interface: LPDDRA4.

I/0 Buffer Type

I/0 Standard for the memory interface signals.

Gearing Ratio

Specifies the ratio relationship between the DDR data speed and the memory controller
speed.

Enable Sideband ECC

Enables error-correction code (ECC) for single-bit error correct and double-bit error
detection (not yet supported).

Enable DBI

Enables data bus inversion (DBI) for better signal integrity and read/write margins .

Read Latency

Specifies the delay from issuing of a read command to receiving read data from SDRAM.

Write Latency

Specifies the delay from issuing of a write command to providing write data to SDRAM.

Data Bus Width

Specifies the total number of data pins in the memory interface.

Enable Training CPU

Enables RISC-V subsystem to support initialization and training of the memory device.
(disabling is not yet supported)

Clock Settings Group

Enable PLL

Enables PLL

DDR Memory Frequency (MHz)

Speed at which the memory controller issues commands to the memory device.

System Clock Frequency (MHz)

Speed to clock the memory controller.

Reference Clock Frequency (MHz)

Indicates the PLL reference clock speed.
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Attribute

Description

DDR Command Actual Frequency
(MHz)

Specifies the actual operating frequency of the memory interface (calculated by the PLL —

includes tolerance).

Clock/Address/Command Group

Number of Clocks

Specifies the number of CK/CK# clock pairs to be driven to SDRAM.

Number of Chip Selects

Specifies the number of chip select (CS) signals to be driven to SDRAM.

Address Width

Specifies number of address pins in memory interface, dependent on the SDRAM density.

3.2.2. LPDDR4 Training Settings

Table 3.13. LPDDR4 Training Settings Attributes

Attribute Selectable Values Default Dependency on Other Attributes
DDR Clock Delay Value 0-20 4 —
DDR Clock Delay Value Incr/Decr Checked/Unchecked Checked —
CS Delay Value 0-20 0 —
CS Delay Value Incr/Decr Checked/Unchecked Checked —
Address Control Delay Value 0-20 0 -
ﬁ]dc?;g?chIOCk Delay Value Checked/Unchecked Unchecked —
Memory CA_Vref Value for RankO 0-114 25 —
Memory CA_Vref Value for Rank1 0-114 25 Enabled when Number of Ranks==2
Memory DQ_Vref Value for Rank0 | 0-114 25 —
Memory DQ_Vref Value for Rankl | 0-114 25 Enabled when Number of Ranks==2
MC DQS Grp<0,1> Vref Value 0-127 40 —
MC DQS Grp<2,3> Vref Value 0-127 40 Enabled when DDR Bus Width>=32
MC DQS Grp<4,7> Vref Value 0-127 40 Enabled when DDR Bus Width>=64
Table 3.14. LPDDR4 PHY 1/0 Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
CK/CS Slew Rate Slow, Fast Fast —
Command Address Slew Rate Slow, Fast Fast -
DQS Slew Rate Slow, Fast Fast —
DQ/DMI Slew Rate Slow, Fast Fast —
MC CA Output Impedance 2300?21(1)200’ 2;‘6;; 0,600, 34Q —
2400,1200Q,68Q, 60 Q,
MC DQ Output Impedance 480,400,340 34 Q -
2400,1200,68 Q,60Q,
MC ODT Value 480,400,340 48 Q -
Table 3.15. LPDDR4 Memory ODT Settings Attributes
Attribute Selectable Values Default Dependency on Other Attributes
Disable, RZQ/1, RZQ/2,
CA_ODT Value RzQ/3, RzQ/4, RZQ/5, RzQ/2 —
RzQ/6
Disable, RZQ/1, RZQ/2,
DQ_ODT Value RzQ/3, RzQ/4, RZQ/5, RzQ/4 —
RzQ/6
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Attribute Selectable Values Default Dependency on Other Attributes
Disable, RZQ/1, RZQ/2,

SoC_ODT Value RzQ/3, RzQ/4, RZQ/5, RzQ/6 —
RzQ/6

CK_ODT Override Enable Checked, Unchecked Unchecked —

CS_ODT Override Enable Checked, Unchecked Unchecked —

CA_ODT Override Disable Checked, Unchecked Unchecked —

ODT-CS/CA/CLK Disable Checked, Unchecked Unchecked —

Pull-Down Drive Strength E;g//i 2;8//3 2?8//2’ RzQ/6 —

Table 3.16. LPDDR4 Training Settings Definitions

Attribute?

Description

Training Settings Group

DDR Clock Delay Value

Specifies the DDR clock delay so that the first DQS toggle is at CK = 0 during write leveling. It
is recommended to increase this value if write leveling fails.

DDR Clock Delay Value Incr/Decr

Specifies the adjustment direction.
Checked: DDR Clock Delay Value is added to the ddr_ck_o signal.
Unchecked: DDR Clock Delay Value is subtracted from the ddr_ck_o signal.

CS Delay Value

Specifies the DDR CS delay value.

CS Delay Value Incr/Decr

Specifies the adjustment direction.
Checked: CS Delay Value is added to the ddr_cs_o signal.
Unchecked: CS Delay Value is subtracted from the ddr_cs_o signal.

Address Control Delay Value

Specifies the DDR address/control signals delay. It is recommended to increase this value if
the command bus training fails.

Address Clock Delay Value
Incr/Decr

Specifies the adjustment direction.

Checked: Address Control Delay Value is added to the DDR address/control signals.
Unchecked: Address Control Delay Value is subtracted from the DDR address/control
signals.

Memory CA_Vref Value for
Rank<0,1>

Specifies the DRAM CA_Vref Value to be written to LPDDR4 DRAM’s MR12 VR-CA and
VREF(CA) for Rank0/Rank1. This should be set based on SI/PI simulation for the target
board design.

Memory DQ_Vref Value for
Rank<0,1>

Specifies the DRAM DQ_Vref Value to be written to LPDDR4 DRAM’s MR14 VR(DQ) and
VREF(DQ) for Rank0/Rank1. When the register field
TRN_OP_REG.mem_vref_training_en=0, this will be used as the final DRAM DQ Vref.

MC DQS Grp<0,1> Vref Value

Specifies the MC DQ_Vref Value for each DQS group when DQ_Vref training is disabled by
setting the register field TRN_OP_REG.mc_vref_training_en=0.
The theoretical mV value is: Vref decimal value x 5 mV.

LPDDR4 MC I/0 Settings

CK/CS Slew Rate

Specifies the CK/CS driver strength.

Command Address Slew Rate

Specifies the CA driver strength.

DQS Slew Rate

Specifies the DQS driver strength.

DQ/DMI Slew Rate

Specifies the DQ/DMI driver strength.

MC CA Output Impedance

Memory controller CA I/0 impedance to reach the VDDQ threshold.

MC DQ Output Impedance

Memory controller DQ I/0 impedance to reach the VDDQ threshold.

MC ODT Value

Memory controller termination resistance value at FPGA.

LPDDR4 Memory ODT Settings

CA_ODT Value

Memory side CA ODT resistance value.

DQ_ODT Value

Memory side DQ ODT resistance value.

CK_ODT Override Enable

Overrides the default CK ODT value for the non-terminating rank when option is checked.
Refer to MR22 in LPDDR4 device datasheet for more details.
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Attribute?!

Description

CS_ODT Override Enable

Overrides the default CS ODT value for the non-terminating rank when option is checked.
Refer to MR22 in LPDDR4 device datasheet for more details.

CA_ODT Override Disable

Disables the termination for CA when option is checked. Refer to MR22 in LPDDR4 device
datasheet for more details.

ODT-CS/CA/CLK Disable

Disables ODT for CS/CA/CLK when option is checked.

Pull-Down Drive Strength

Specifies drive strength for pull-down resistor.

Note:

1. Modify these attributes only when you encounter an error during LPDDR4 memory training.
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4. Signal Description

The input and output signals of the DDRPHY are discussed in the following section.

4.1. Clock and Reset

Table 4.1. Clock and Reset Port Definitions
Port Name 1/0 Width Description

PLL reference clock input. It is recommended to use 100 MHz for better
clock performance.

pll_refclk_i In 1

pll_rst_n_i In 1 PLL reset active low.

Clock for APB interface, training CPU and control logic of the internal
PLL. This clock is independent of sclk_o, since sclk_o stops during clock
frequency changes.

Supports 50 MHz to 150 MHz in simulation, but the upper limit for
implementation may be less than 150 MHz, depending on the Radiant
timing analysis report.

pelk_i In 1

Asynchronous active low reset for APB interface. This reset must be de-

reset_n_i In 1 .
P - = asserted synchronous to pclk_i.

pll_lock_o Out 1 PLL lock output indicating when PLL is locked.

System clock. This is % of the DDR clock frequency and is the main clock
of the DDRPHY IP.

Asynchronous active high reset. When asserted, output ports and
registers are forced to their reset values. The DDRPHY IP implements
logic to de-assert the internal reset synchronously to the internal clocks
after rst_i de-asserts. The minimum pulse width is 2x the period of
pclk_i. After rst_i deassertion, wait for a minimum of 5 pclk_i before
accessing the registers.

sclk_o Out 1

rst_i In 1

4.2. Interrupts and Initialization/Training

Table 4.2. Interrupts and Initialization/Training Port Definitions

Port Name 1/0 Width Description
Interrupt signal
irqg_o Out 1 P g. ,
Reset value is 1’b0
turn off addr ctrl drv i | In 1 Dlsa.bles the output drive of the DDR CK, CS, and CA signals by setting
- - - - - to high-Z.
trn_done_o Out 1 Indicates completion of initialization and training.
trn_err_o Out 1 Indicates failure in training.

4.3. APB Register Interface

This section describes the configuration interface port in the DDRPHY IP. Refer to the AMBA APB Protocol Specification
for a description of these signals.
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Table 4.3. APB Interface Port Definitions
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Port Name 1/0 Width Description
APB Select signal
apb_psel_i In 1 Indicates that the subordinate device is selected, and a data transfer is
required.
apb_paddr_i In 12 APB Address signal
. APB Write data signal
apb_pwdata i In 32 Bits [31:8] are not used
L APB Direction signal
apb_pwrite_i In 1 .
1 = Write, 0 = Read
. APB Enable signal
apb_penable_i In 1 ]
Indicates the second and subsequent cycles of an APB transfer.
APB Ready signal
apb_pready o Out 1 Indicates transfer completion. The subordinate uses this signal to extend
an APB transfer. The reset value is 1’b0.
apb_pshverr o out 1 APB Error signal
- - Indicates a transfer failure. This signal is tied to 1’b0.
apb_prdata_o Out 32 APB Read data signal

4.4. DFI 4.0 PHY Interface

This section describes the data interface port when the Local Data Bus Type attribute is set to AXI4 in the DDRPHY IP.
These ports are available only when using IP Core v2.x.x. Refer to the DFI 4.0 Specification for a description of these

signals.

Table 4.4. AXI4 Interface Port Definitions

Port Name 1/0 Width Description

dfi_reset_n_i In 1 Reset for DFl interface

dfi_ctrlupd_req_i In 1 DFI MC-initiated update request signal

dfi_phyupd_ack_i In 1 DFI PHY-initiated update acknowledge signal

dfi_cke_p<0,1,2,3>_i In CK_WIDTH DFI clock enable signal

dfi_cs_p<0,1,2,3> i In CS_WIDTH DFI chip select (active low)

dfi_ca_p<0,1,2,3> i In DFI_CA_WIDTH DFl address bus

dfi_ba_p<0,1,2,3>_i In BA_WIDTH DFI bank address

dfi_ras_n_p<0,1,2,3>_i In 1 DFI row address strobe

dfi_cas_n_p<0,1,2,3>_i In 1 DFI column address strobe

dfi_we_n_p<0,1,2,3>_i In 1 DFl write enable

dfi_odt_p<0,1,2,3>_i In 1 DFI on-die termination

dfi_wrdata_cs_p<0,1,2,3> i | In CS_WIDTH DFI write data chip select (active low)

dfi_wrdata_en_p<0,2>_i In 1 DFI write data and data mask enable

dfi_wrdata_i In BUS_WIDTH*8 DFI write data

dfi_wrdata_mask_i In BUS_WIDTH DFI write data byte mask

dfi_rddata_cs_p<0,1,2,3>_i | In CS_WIDTH DFI read data chip select (active low)

dfi_rddata_en_p<0,2>_i In 1 DFl read data enable

dfi_rddata_o Out BUS_WIDTH*8 DFI read data

dfi_rddata_dbi_o Out BUS_WIDTH DFI read data bus inversion

dfi_rddata_valid_p<0,2> 0 | out BUS_WIDTH/8 DFl read daFa valid indicator. Each bit indicates read data valid for
corresponding data lane.

dfi_ctrlupd_ack_o Out 1 DFI MC-initiated update acknowledge signal

dfi_phyupd_req_o Out 1 DFI PHY-initiated updated request signal
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Port Name 1/0 Width Description
dfi_phyupd_type_o Out 2 DFI PHY-initiated update select signal
dfi_init_complete_o Out 1 DFl initialization complete signal

4.5. Memory Interface Signals

4.5.1. DDR4 Memory Interface
This section describes the interface ports for DDR4 SDRAM.

Table 4.5. DDR4 Interface Port Definitions

Port Name 1/0 Width Description
ddr_ck_o?? Out CK_WIDTH DDR4 CK signal
ddr_cke_ o2 Out CK_WIDTH DDR4 CKE signal
ddr_cs_o'? Out CS_WIDTH DDRA4 CS signal
ddr_ca_o? Out CA_WIDTH DDR4 CA signal
ddr_we_n_o? Out 1 DDR4 WE signal
ddr_cas_n_o? Out 1 DDR4 CAS signal
ddr_ras_n_o? Out 1 DDR4 RAS signal
ddr_act_n_o? Out 1 DDR4 ACT_n signal
ddr_ba_o'? Out BANK_WIDTH DDR4 BA signal
ddr_bg o012 Out BG_WIDTH DDR4 BG signal
ddr_odt_o12 Out ODT_WIDTH DDR4 ODT signal
ddr_reset_n_o? Out 1 Memory reset signal
ddr_dq_io? In/Out | BUS_WIDTH DDR4 DQ signal
ddr_dgs_io? In/Out | DQS_WIDTH DDR4 DQS signal
ddr_dmi_io? In/Out | DQS_WIDTH DDR4 DM signal
Notes:

1. The bit width of SDRAM Memory Interface signals is defined based on the attributes listed in Table 3.1 and Table 3.3.
2. For component, terminate the command, address and control signals to VTT on the board. This is not needed for UDIMM
because it already has the termination within the UDIMM.

4.5.2. LPDDR4 Memory Interface
This section describes the interface ports for LPDDR4 SDRAM.

Table 4.6. LPDDR4 Interface Port Definitions

Port Name 1/0 Width Description
ddr_ck_o! Out CK_WIDTH LPDDR4 CK signal
ddr_cke_o? Out CK_WIDTH LPDDR4 CKE signal
ddr_cs_o? Out CS_WIDTH LPDDR4 CS signal
ddr_ca_o Out 6 LPDDR4 CA signal
ddr_reset_n_o Out 1 Memory reset signal
ddr_dq_io? In/Out | BUS_WIDTH LPDDR4 DQ signal
ddr_dgs_io? In/Out | DQS_WIDTH LPDDR4 DQS signal
ddr_dmi_io? In/Out | DQS_WIDTH LPDDR4 DM signal
Note:

1. The bit width of SDRAM Memory Interface signals is defined based on the attributes listed in Table 3.9 and Table 3.11.
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This section describes the user-accessible registers in the DDRPHY. Some registers are reserved for internal CPU usage
and you should not write to them. Writing to these registers may cause failures during the initialization and training

operations.

Table 5.1. Summary of DDRPHY Module Registers

Offset Register Name Access Type Description

0x000 to OX1EC IF_<|(;srzr|vped for DDRPHY . aAgzer:sssisf:s::;\;e:rin;:;:;rr?;r;:g CPU. Do not access this

0x200 FEATURE_CTRL_REG RO Feature Control Register

0x204 RESET_REG RW Reset Register

0x208 SETTINGS_REG RW Settings Register

0x20C PHY_CLK_REG RW PHY Clock Control and Status Register

0x210 INT_STATUS_REG WR1C Interrupt Status Register

0x214 INT_ENABLE_REG RW Interrupt Enable Register

0x218 INT_SET_REG \uYe} Interrupt Set Register

0x21¢ INIT_CTRL_REG wo 5\7::::’: fcjof('zl'rmiszSrzgbi\s/t'ie.l"rewll?lItec:qlr:.laslecLFl)nUe.xpected behavior.

0x220 TRN_OP_REG RW Training Operation Register

0x224 STATUS_REG RW Training Status Register

Reserved for DDRPHY Access is reserved for the Training CPU. Do not access this

0x228 to 0x22¢ Hard IP - address from your APB interface.g

0x230 MRW_CTRL_REG \uYe} DDR Mode Register Write Control Register

0x234 to 0x23C | Reserved RSVD Reserved

0x240 to 0x244 E':srzrlvpeg;‘ﬁ[ngRPHY RSVD Access is reserved for the Training CPU debug information.

0x250 CK_ADRCTRL_TRIM RW Clock/Address/Control Trim Setting Register to specify delay.

0x254 ODT_SETTING RW ODT setting register to set ODT value.

0x258 Reserved RSVD Reserved

0x25C DRAM_VREF_REG RW DRAM Vref Register Setting

0x260 PHY_VREF_0_3_REG RW PHY Vref setting for DQS Groups 0 to 3.

0x264 PHY_VREF_4_7_REG RW PHY Vref setting for DQS Groups 4 to 7.

0x268 PHY_VREF_8_REG RW PHY Vref setting for DQS Group 8.

O0X26C t0 0x294 | Reserved for Training RSVD Access is reserved for the Training CPU. Do not access this
address from your APB interface.

0x298 to Ox3FC | Reserved RSVD Reserved

0x400 to 0x46C | Reserved for PLL . Access is reserved for the Training CPU. Do not access this
address from your APB interface.

0x470 to Ox7FC | Reserved RSVD Reserved

Note: The behavior of registers to write and read access is defined by its access type, which is defined in Table 5.2.
Table 5.2. Register Access Type Definitions

Access Type Behavior on Read Access Behavior on Write Access

RO Returns register value Ignores write access

\"Ye] Returns 0 Updates register value

RW Returns register value Updates register value

WRILC Returns register value Writ?ng 1’blon reg?ster bit -cIe.ars the bit to 1’b0
Writing 1’b0 on register bit is ignored

RSVD Returns O Ignores write access
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5.1. Feature Control Register (FEATURE_CTRL_REG) (0x200)

The Feature Control Register reflects the modes of operation specified by the attributes selected during IP
configuration. These attributes are set during IP configuration and cannot be modified at runtime. The CPU reads this
register to identify the modes of operation.

Table 5.3. Feature Control Register

Field Name Access Width Reset

[31:21] reserved RSVD 11 —

[20] reset_init_by_phy RO 1 1

[19:17] reserved RSVD 3 —

[16] num_ranks RO 1 Number of Ranks
[15:12] ddr_width RO 4 DDR Bus Width
[11:8] ddr_type RO 4 DDR Interface Type
[7:4] reserved RSVD 4 —

[3] gear_ratio RO 1 Gearing Ratio

[2] reserved RSVD 1 —

[1] dbi_en RO 1 Enable DBI

[0] ecc_en RO 1 Enable SideBand ECC

reset_init_by_phy
e Enables the logic and routine that drive the ddr_reset_n_o and ddr_cke_o signals during memory initialization, as
well as the initial mode register writes and ZQ calibration right after the initialization. This is fixed to 1 for the first
release.
e 0—DDRPHY resets and initializes the memory
e 1 —PHY resets and initializes the memory
num_ranks
e The num_ranks specify the number of DDR ranks as follows:
e 0-Single rank
e 1-Dualrank
ddr_width
e The ddr_width specifies the bit width of the DDR data bus as follows:
e 0-—DDR Bus Width = 8 bits
e 1-DDR Bus Width = 16 bits
e 2 -—reserved
e 3 —DDR Bus Width = 32 bits or 40 bits
e 4 -4’h6:reserved
e 7 —DDR Bus Width = 64 bits or 72 bits

ddr_type
e The ddr_type specifies the DDR standard implemented by the DDRPHY IP Core. This is based on the Interface Type
attribute.

e 4 —|nterface Type = DDR4

e 12 —Interface Type = LPDDR4

gear_ratio

e The gear_ratio specifies the ratio of clock frequency of DDR clock domain and system clock domain. This is based
on the Gearing Ratio attribute.

e 0-4:1gearing: ddr_ck_o frequency = 2 x sclk_o frequency

e 1-8:1gearing: ddr_ck_o frequency = 4 x sclk_o frequency
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dbi_en

e The dbi_en enables the data bus inversion function to reduce the toggling of DDR data signal in the board, thus
improving the signal integrity and reducing dynamic power consumption. The DBl is only enabled on the read path
and is always disabled on the write path to support masked write function. This mode is based on the Enable Read
DBI attribute.

ecc_en
e The ecc_en enables the sideband ECC function. This mode is based on the Enable Sideband ECC attribute.

5.2. Reset Register (RESET_REG) (0x204)

The Reset Register controls the reset of the internal CPU and Training Engine, both of which reset at power-on. The
host de-asserts the reset to the internal CPU and Training Engine to begin memory initialization and training. Upon
training completion, the internal CPU sets the trn_eng_rst_n signal low (RESET_REG[0]=0) to place the Training Engine
in reset to save power. This register does not reset the Configuration Set Registers (CSRs).

Table 5.4. Reset Register

Field Name Access Width Reset

[31:1] reserved RSVD 31 —

[0] cpu_reset_n RW 1 0
cpu_reset_n

e Reset input to the training CPU. This register is in a reset state at power-on. The host un-reset this register to start
the memory initialization and training. Upon training completion, the internal CPU writes to this register to return
the Memory Training Engine to reset state, thus saving power consumption. This register does not reset the CSR.

5.3.

Settings Register (SETTINGS_REG) (0x208)

The Settings Register controls the DDR write and read latencies according to the attributes selected during IP

configuration.

Table 5.5. Settings Register

Field Name Access Width Reset

[31:28] reserved RSVD 4 —

[27:16] cmd_freq RO 12 DDR Memory Frequency

[15:8] read_latency RW 8 Read Latency

[7:0] write_latency RW 8 Write Latency
cmd_freq

e The cmd_freq reflects the DDR Memory Frequency attribute value. The training routine uses this value to trim the
initial delay settings of the DDR signals.

read_latency
e The read_latency specifies the number of DDR clock cycles from read command to the first read data.

write_latency
e The write_latency specifies the number of DDR clock cycles from write command to the first write data.
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5.4. PHY Clock Register (PHY_CLOCK_REG) (0x20C)

The training CPU uses the PHY Clock Register shown in Table 5.6 during clock frequency changes. The host CPU reads
this register to determine the clock frequency and lock status. You should not write to this register.

Table 5.6. PHY Clock Register
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Field Name Access Width Reset
[31:16] reserved RSVD 16 —
[15:4] pll_refclk RO 12 Reference Clock Frequency
[3] prim_rst_en_cfc WO 1 —
[2] pll_reset WO 1 —
[1] pll_lock RO 1 —
[0] disable_clkophy WO 1 0
pll_refclk
e  Returns the PLL reference clock frequency in MHz.
prim_rst_en_cfc
e Enables the reset of the DDR primitives during clock frequency change.
pll_reset
e Used by the Training CPU to reset the PLL during clock frequency change so that the PLL locks on the new
frequency.
pll_lock

e Asserts when PLL is locked.

disable_clkophy
e Setto 1to disable the PLL output clock going to the DDRPHY and ECLKSYNC hard IPs.

5.5. Interrupt Status Register (INT_STATUS_REG) (0x210)

Table 5.7 lists all the pending interrupts supported in the DDRPHY Module. When an interrupt bit asserts, it remains
asserted until the host clears it by writing 1’b1 to the corresponding bit.

The interrupt status bits are independent of the interrupt enable bits. In other words, status bits may indicate pending
interrupts, even though those interrupts are disabled in the Interrupt Enable Register. User logic that handles
interrupts should mask (bitwise and logic) the contents of INT_STATUS_REG and INT_ENABLE_REG to determine which
interrupts to service. The irq_o interrupt signal asserts whenever both an interrupt status bit and the corresponding
interrupt enable bits are set.

Table 5.7. Interrupt Status Register

Field Name Access Width Reset

[31:2] reserved RSVD 30 —

[1] trn_err_int WR1C 1 0

[0] trn_done_int WR1C 1 0
trn_err_int

e Training Error Interrupt. This interrupt bit asserts when the Memory Training Engine encounters an error during
training. Read the status register to determine the specific error.

e 0-Nointerrupt

e 1-Interrupt pending
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trn_done_int

e Training Done Interrupt. This interrupt bit asserts when initialization and training is completed successfully.
e 0-Nointerrupt

e 1-Interrupt pending

5.6. Interrupt Enable Register (INT_ENABLE_REG) (0x214)

The Interrupt Enable Register lists all configurable interrupts within the DDRPHY.

Table 5.8. Interrupt Enable Register

Field Name Access Width Reset

[31:2] reserved RSVD 30 —

[1] trn_err_en RW 1 0

[0] trn_done_en RW 1 0
trn_err_en

e Training Error Interrupt Enable.
e 0-—lInterrupt disabled

e 1-Interrupt enabled
trn_done_en

e Training Done Interrupt Enable.
e 0-Interrupt disabled

e 1-Interrupt enabled

5.7. Interrupt Set Register (INT_SET_REG) (0x218)

Table 5.9 shows a summary of the Interrupt Set Register. Writing 1’b1 to a register bit in this register asserts the
corresponding interrupt status bits in INT_STATUS_REG. Writing 1'b0 is ignored.

Table 5.9. Interrupt Set Register

Field Name Access Width Reset

[31:2] reserved RSVD 30 —

[1] trn_err_set WO 1 0

[0] trn_done_set WO 1 0
trn_err_set

e Training Error Interrupt Set.

e 0-Noaction

e 1-—Asserts INT_STATUS_REG.trn_err_int
trn_done_set

e Training Done Interrupt Set.

e 0-No action

e 1-—Asserts INT_STATUS_REG.trn_done_int
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5.8. Training Operation Register (TRN_OP_REG) (0x220)

Table 5.10 summarizes the Training Operation Register, which controls the memory initialization and training. Set these
register bits to 1’b0 during simulation to shorten the initialization and training procedure.

Table 5.10. Training Operation Register

Field Name Access Width Reset
[31:10] reserved RSVD 22 —
[9] phy_2d_vref_en RW 1 0
[8] bit_Ivl_trim_sweep_en | RW 1 0
[7] mem_verf_training_en | RW 1 1
[6] mc_vref_training_en RW 1 1
[5] ca_vref_training_en RW 1 0
[4] write_trn_en RW 1 1
[3] read_trn_en RW 1 1
[2] write_Ivl_en RW 1 1
[1] cbt_en RW 1 1
[0] init_en RW 1 1

phy_2d_vref_en

e The phy_2d_vref_en performs 2D VREF training to improve performance by addressing voltage variation both
horizontally and vertically. This setting requires bit_Ivl_trim_sweep_en = 1. Refer to the VREF Training and Bit-
Level Trim Sweep sections of this user guide for more details.

bit_Ivl_trim_sweep

e The bit_Ivl_trim_sweep centers the DQ valid window to the DQS edge for each DQ bit. Refer to the Bit-Level Trim
Sweep section of this user guide for more details.

mem_verf_training_en

e The mem_vref_trn_en enables the memory’s DQ Vref training. When enabled, the DDRPHY performs write
training across multiple memory Vref points and selects the optimal Vref value. Refer to the VREF Training section
of this user guide for more details.

mc_vref_training_en

e The mc_vref_trn_en enables the DDRPHY’s DQ Vref training. When enabled, the DDRPHY performs write training
across multiple Vref points of the FPGA’s |/O and selects the optimal Vref value. Refer to the VREF Training section
of this user guide for more details.

ca_vref_trn_en

e The ca_vref_trn_en enables the memory’s CA Vref training. When enabled, the DDRPHY performs CA training
across multiple CA_Vref points and selects the optimal CA_Vref value. This bit is currently unused because we
recommend setting the CA_Vref based on the SI/PI simulation for the target board design. Refer to the VREF
Training section of this user guide for more details.

write_trn_en

e The write_trn_en enables the write DQ bit leveling. The write training optimizes the write DQ delay with respect to
the write DQS to improve the data valid window for writes. Refer to the Write Training (Write Bit-Leveling) section
of this user guide for more details.

read_trn_en

e Theread_trn_en enables the read DQ bit leveling. This register optimizes the read DQ with respect to read DQS to
improve the data valid window for reads. Refer to the Read Training (Read Bit-Leveling) section of this user guide
for more details.
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write_lvl_en

e The write_lvl_en enables the write leveling during initialization and training. The write leveling compensates for
CK-DQS timing skews. Refer to the Write Leveling section of this user guide for more details.

cbt_en

e The cbt_en enables the command bus during initialization and training. The command bus training performs
CA_VREF programming and center aligns the CS/CA to CK for high frequency operation. See the Command Bus
Training section for details. The command bus training is always performed as required by the LPDDR4 standard.
This bit only disables the clock frequency change for faster simulation because this process requires long
simulation time.

e 0-The clock frequency change is not performed during CBT

e 1-The clock frequency change is performed during CBT

init_en

e Theinit_en provides option to shorten the initialization for simulation purposes.

e 0 -—Initialization is significantly reduced. For example, reset time and CKE low time is significantly shortened

e 1 -—Initialization is complete according to the corresponding DDR standard

5.9. Training Status Register (TRN_STATUS_REG) (0x224)

Table 5.11 summarizes the Training Status Register. This register is written by the internal CPU to communicate the
status to the system CPU.

Table 5.11. Training Status Register

Field Name Access Width Reset
[31:24] reserved RSVD 8 —
[23:20] retraining_count RW 4 0
[19:18] reserved RSVD 2 —
[17] phy_2d_vref_done RW 1 0
[16] bit_Ivl_trim_sweep_done RW 1 0
[15:14] err_on_rank RW 2 0
[13] blts_err RW 1 0
[12] scl_err RW 1 0
[11] write_training_err RW 1 0
[10] read_training_err RW 1 0
[9] write_Ivl_err RW 1 0
(8] cbt_err RW 1 0
[7] rankl_done RW 1 0
[6] rankO_done RW 1 0
[5] scl_done RW 1 0
[4] write_training_done RW 1 0
[3] read_training_done RW 1 0
[2] write_Ivl_done RW 1 0
[1] cbt_done RW 1 0
[0] init_done RW 1 0
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retraining_count

e Inthe event of a command bus training, write levelling, or read dg-bit leveling error, the Training CPU attempts to
calibrate the DDR/LPDDR interface again with updated training settings. The retraining_count keeps track of the
number of retries attempted by the Training CPU to successfully pass the DDR/LPDDR training routine, with a
maximum of five retrains.

phy_2d_vref_done

e Asserts when 2D VREF training has completed.

bit_Ivl_trim_sweep_done

e Asserts when bit-level trim sweep has completed.

err_on_rank

e Indicates which rank has encountered an error.

e  2’bx1:training error on rank 0

e  2’blx:training error on rank 1

blts_err

e Asserts when a failure occurs during bit-level trim sweep.

scl_err

e Asserts when a failure occurs during self-calibrating logic.

write_trn_err

e Asserts when a failure occurs during write training.

read_trn_err

e Asserts when a failure occurs during read training.

write_Ivl_err

e Asserts when a failure occurs during write leveling.

cbt_err

e Asserts when a failure occurs during command bus training.

rank1l_done

e Asserts when training as completed for rank 1.

rank0_done

e Asserts when training as completed for rank 0.

scl_done

e Asserts when self-calibrating logic has completed.

write_training_done

e Asserts when write training has completed.

read_training_done

e Asserts when read training has completed.

write_lvl_done

e Asserts when write levelling has completed.

cbt_done

e Asserts when command bus training has completed.

init_done

e  Asserts when PHY initialization has completed.
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5.10. Mode Register Write Control Register (MRW_CTRL_REG) (0x230)

Table 5.12 summarizes the Mode Register Write Control Register. The training CPU writes to this register to perform
mode register writes to the memory device. This register should not be used for normal operation. It may be used for
debugging purposes when the DRAM is in an idle state. Note that setting an inappropriate mode register value will
cause failure in operation.

Table 5.12. Mode Register Write Control Register

Field Name Access Width? 2 Reset

[31:0PW+8] reserved RSVD 24-OPW —

[OPW+7:8] mrw_op wo OoPW —

[7:MAW] reserved RSVD 8-MAW —

[MAW-1:0] mrw_ma wo MAW —
Notes:

1. For DDR4: OPW =14, MAW =3
2. For LPDDR4: OPW =8, MAW =6

mrw_op

e Specifies the opcode for mode register write.

mrw_ma

e Specifies the mode register address to write to.

5.11. Clock/Address/Control Trim Register (CK_ADRCTRL_TRIM_REG) (0x250)

Table 5.13 summarizes the Clock/Address/Control Trim Settings Register. The reset value is set by the selected GUI

attributes during IP generation. The training CPU reads this register and sets the corresponding DDR Hard IP registers.
To try different settings on hardware, write to this register before releasing the reset of the training CPU. This method
is useful for debugging command bus training and write leveling errors.

Table 5.13. Clock/Address/Control Trim Settings Register

Field Name Access Width Reset

[31:25] reserved RSVD 8 -

[23] adrctrl_dly_val_inc RW 1 Address Control Delay Value
Incr/Decr

[22:16] adrctrl_dly_val RW 7 Address Control Delay Value

[15] cs_dly_val_incr RW 1 CS Delay Value Incr/Decr

[14:8] cs_dly_val RW 7 CS Delay Value

[7] ck_dly_val_incr RW 1 DDR Clock Delay Value Incr/Decr

[6:0] ck_dly_val RW 7 DDR Clock Delay Value

adrctrl_dly_val_inc

e  Specifies whether the delay value is added or subtracted in relation to the address/control delay of the DDRPHY

Hard IP.

e (0—adrctrl_dly val is subtracted from the address/control delay of the DDRPHY Hard IP.

e 1 —adrctrl_dly_val is added to the address/control delay of the DDRPHY Hard IP.
adrctrl_dly_val

e  Specifies the delay (humber of delay taps) to be added or subtracted in relation to the address/control delay of the

DDRPHY Hard IP.
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cs_dly_val_inc

e Specifies whether the delay value is added or subtracted in relation to the chip select delay of the DDRPHY Hard
IP.

e (0-cs_dly_valis subtracted from the chip select delay of the DDRPHY Hard IP.

e 1-—cs_dly_valis added to the chip select delay of the DDRPHY Hard IP.

cs_dly_val

e Specifies the delay (number of delay taps) to be added or subtracted in relation to the chip select delay of the
DDRPHY Hard IP.

ck_dly_val_incr
e Specifies whether the delay value is added or subtracted in relation to the DRAM clock delay of the DDRPHY Hard
IP.

e 0-—ck_dly_valis subtracted from the DRAM clock delay of the DDRPHY Hard IP.
e 1-—ck_dly_valis added to the DRAM clock delay of the DDRPHY Hard IP.
ck_dly_val

e Specifies the delay (number of delay taps) to be added or subtracted in relation to the DRAM clock delay of the
DDRPHY Hard IP.

5.12. ODT Settings Register (ODT_SETTINGS_REG) (0x254)

The ODT Settings Register specifies the ODT settings to be written to the DRAM during initialization. The training CPU
reads this register and sets the corresponding LPDDR4/DDR4 memory mode registers. The Table 5.14 shows the ODT
Settings Register for LPDDR4, while Table 5.15 shows the ODT Settings Register for DDR4.

Table 5.14. ODT Settings Register for LPDDR4

Field Name Access Width Reset

[31:19] reserved RSVD 13 —

[18:16] odtr_pdds RW 3 Pull-Down Drive Strength

[15:14] X80DTD RW 2 ODT-CS/CA/CLK

[13] odtd_ca RW 1 CA_ODT Override Disable

[12] odte_cs RW 1 CS_ODT Override Enable

[11] odte_ck RW 1 CK_ODT Override Enable

[10:8] soc_odt_val RW 3 SoC ODT Value

[7] reserved RSVD 1 —

[6:4] ca_odt_val RW 3 CA_ODT Value

[3] reserved RSVD 1 —

[2:0] dg_odt_val RW 3 DQ_ODT Value
odtr_pdds

e Specifies the pull-down drive strength settings to be written to LPDDR4 memory mode register 3 (MR3).
X80DTD

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 22 (MR22).
odtd_ca

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 22 (MR22).
odte_cs

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 22 (MR22).

odte_ck
e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 22 (MR22).

www.latticesemi.com/legal


http://www.latticesemi.com/legal

soc_odt_val

= LATTICE

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 22 (MR22).

ca_odt_val

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 11 (MR11).

dg_odt_val

e Specifies the corresponding ODT settings to be written to LPDDR4 memory mode register 11 (MR11).

Table 5.15. ODT Settings Register for DDR4

Field Name Access Width Reset

[31:11] reserved RSVD 13 —

[10:8] rtt_park_val RW 3 RTT_PARK Value

[7] reserved RSVD 1 —

[6:4] rtt_wr_val RW 3 RTT_WR Value

[3] reserved RSVD 1 —

[2:0] rtt_nom_val RW 3 RTT_NOM Value
rtt_park_val

e Specifies the corresponding ODT settings to be written to DDR4 memory mode register 5 (MR5).

rtt_wr_val

e Specifies the corresponding ODT settings to be written to DDR4 memory mode register 2 (MR2).

rtt_nom_val

e Specifies the corresponding ODT settings to be written to DDR4 memory mode register 1 (MR1).

5.13. DRAM VREF Register (DRAM_VREF_REG) (0x25C)

The DRAM VREF Register specifies the Vref values written in the DRAM during initialization. When DRAM side Vref
training is disabled, this register specifies the Vref settings. Table 5.16 shows the DRAM Vref Register.

Table 5.16. DRAM VREF Register

Field Name Access Width Reset
[31] reserved RSVD 1 —
[30:24] dram_vref_ca_r1 RW 7 Memory CA_Vref Value for
Rank1
[23] reserved RSVD 1 —
[22:16] dram_vref_dq_r1 RW 7 Memory DQ_Vref Value for
Rank1
[15] reserved RSVD 1 —
[14:8] dram_vref_ca_r0 RW 7 Memory CA_Vref Value for
RankO
[7] reserved RSVD 1 —
. Memory DQ_Vref Value for
[6:0] dram_vref_dq_r0 RW 7 Ranko

dram_vref_ca_rl

e Specifies the Vref value to be written to LPDDR4 Rank 1 MR12 VR(CA) and VREF(CA).

e Thisis not used in DDR4 mode.
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dram_vref_dq_rl
e Specifies the Vref value to be written to:
e When LPDDR4 mode: Rank 1 MR14 VR(DQ) and VREF(DQ).
e  When DDR4 mode: Rank 1 MR6 VrefDQ Training Range and Value.
dram_vref_ca_r0
e Specifies the Vref value to be written to LPDDR4 Rank 0 MR12 VR(CA) and VREF(CA).
e This is not used in DDR4 mode.
dram_vref_dq_r0
e  Specifies the Vref value to be written to:
e When LPDDR4 mode: Rank 0 MR14 VR(DQ) and VREF(DQ).
e  When DDR4 mode: Rank 0 MR6 VrefDQ Training Range and Value.

5.14. PHY VREF Register for DQS Groups 0-3 (PHY_VREF_0_3_REG) (0x260)

Table 5.17 displays the PHY VREF Register for DQS Groups 0 to 3. This register specifies the initial Vref values for DQS
Groups 0 to 3. When PHY Vref Training is disabled (TRN_OP_REG.mc_vref_training_en=0), the value set in this register
becomes the final Vref value.

Table 5.17. PHY VREF Register for DQS Groups 0-3

Field Name Access Width Reset

[31] reserved RSVD 1 —

[30:24] phy_vref_dgs_grp3 RW 7 MC DQS Grp3 Vref Value
[23] reserved RSVD 1 —

[22:16] phy_vref_dgs_grp2 RW 7 MC DQS Grp2 Vref Value
[15] reserved RSVD 1 —

[14:8] phy_vref_dqgs_grpl RW 7 MC DQS Grp1 Vref Value
[7] reserved RSVD 1 —

[6:0] phy_vref_dqgs_grp0 RW 7 MC DQS Grp0 Vref Value

phy_vref_dqgs_grp3

e Specifies the initial Vref value for DDRPHY DQS Group 3.

phy_vref_dqs_grp2

e Specifies the initial Vref value for DDRPHY DQS Group 2.

phy_vref_dqgs_grpl

e Specifies the initial Vref value for DDRPHY DQS Group 1.

phy_vref_dqs_grp0

e Specifies the initial Vref value for DDRPHY DQS Group 0.
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5.15. PHY VREF Register for DQS Groups 4-7 (PHY_VREF_4_7_REG) (0x264)

Table 5.18 displays the PHY VREF Register for DQS Groups 4 to 7. This register specifies the initial Vref values for DQS
Groups 4 to 7. When PHY Vref Training is disabled (TRN_OP_REG.mc_vref_training_en=0), the value set in this register

becomes the final Vref value.

Table 5.18. PHY VREF Register for DQS Groups 4-7

Field Name Access Width Reset

[31] reserved RSVD 1 —

[30:24] phy_vref_dqgs_grp7 RW 7 MC DQS Grp7 Vref Value
[23] reserved RSVD 1 —

[22:16] phy_vref_dqgs_grp6 RW 7 MC DQS Grp6 Vref Value
[15] reserved RSVD 1 —

[14:8] phy_vref_dqs_grp5 RW 7 MC DQS Grp5 Vref Value
[7] reserved RSVD 1 —

[6:0] phy_vref_dqgs_grp4 RW 7 MC DQS Grp4 Vref Value

phy_vref_dqs_grp7

e  Specifies the initial Vref value for DDRPHY DQS Group 7.

phy_vref_dqs_grp6

e Specifies the initial Vref value for DDRPHY DQS Group 6.

phy_vref_dqs_grp5

e Specifies the initial Vref value for DDRPHY DQS Group 5.

phy_vref_dgs_grp4

e  Specifies the initial Vref value for DDRPHY DQS Group 4.

5.16. PHY VREF Register for DQS Group 8 (PHY_VREF_8_REG) (0x268)

Table 5.19 displays the PHY VREF Register for DQS Group 8. This register specifies the initial Vref values for DQS
Group 8. When PHY Vref Training is disabled (TRN_OP_REG.mc_vref_training_en=0), the value set in this register

becomes the final Vref value.

Table 5.19. PHY VREF Register for DQS Group 8

Field Name Access Width Reset
[31:7] reserved RSVD 25 —
[6:0] phy_vref_dqgs_grp8 RW 7 MC DQS Grp8 Vref Value

phy_vref_dqs_grp8

e Specifies the initial Vref value for DDRPHY DQS Group 8.
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6. DDRPHY Example Design

This section describes the DDR Memory PHY Module Example Design, which is available to users for synthesis and
simulation after successful IP generation. This example design does not support hardware evaluation. For hardware
evaluation, refer to the DDR Memory Controller IP and DDR Memory Controller IP User Guide (FPGA-IPUG-02208). For
steps on generating the DDRPHY IP Core, refer to the Designing and Simulating the IP section of this user guide.

6.1. Synthesis Example Design

After generating of the DDR Memory PHY, you have access to a synthesizable example design. This design allows you to
run the Radiant flow to check resource utilization and Fmax for the selected DDR PHY Module IP configuration; it is not
for hardware evaluation. For hardware evaluation, refer to the DDR Memory Controller IP and DDR Memory Controller
IP User Guide (FPGA-IPUG-02208). Figure 6.1 shows a block diagram of the DDR Memory PHY Module Synthesis
Example Design.

Top-Level Example Design Wrapper

________________________________________________________________

polk_i domain
(configuration I/F)
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Figure 6.1. DDR Memory PHY Module Synthesis Example Design Diagram

The main blocks that make up the synthesizable example design include the following:
e Configuration interface (APB) block — This is an APB requestor to initiate training and is used for static timing
analysis.

e DFI controller block — This drives the DFl interface. This block does not generate traffic data and is used only for
testing the Radiant flow and static timing analysis.

e DDRPHY block — This is the DDR Memory PHY module.

The top-level example design wrapper file, eval_top.sv, provides ports for a PLL reference clock, a configuration
interface clock (pclk_i), an APB block, a DFI_M block, and a DDRPHY block.

6.2. Simulation Example Design

The simulation example design is similar to the synthesizable example design, with the following changes:
e External DDR4/LPDDR4 memory is replaced with a DDR4/LPDDR4 memory model.

For instructions on simulating the DDR Memory PHY, including the example design, refer to the Designing and
Simulating the IP section of this user guide.
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7. Designing and Simulating the IP

This section describes the steps required within Lattice Radiant software to configure and generate the DDR Memory
PHY Module. This section also provides information regarding design implementation and resource evaluation of the
synthesizable example design. The screenshots provided in this section are for reference only and the details may vary
depending on the version of the IP or software being used.

7.1. Generating the IP

This section describes the steps required to create, configure, and generate an instance of the DDR Memory PHY
Module.

7.1.1. Creating a Radiant Project
In order to generate an instance of the DDRPHY IP, a Lattice Radiant project must first be created.

1. Launch the Lattice Radiant software and select File > New > Project. This will open the New Project dialog box.
Click Next.

Lattice Radiant Software - Start Page
File Edit View Project Tools Window Help
New P L& File. Ctrl+N
Open v [ Project. Ctrl+Shift+N
Add 3
Close Ctrl+F4
Close All
B saveall Ctrl+Shift+5
Recent Files >
Recent Projects 3
Exit

Figure 7.1. Creating a New Radiant Project

2. Specify a name (<project_name>) for the Lattice Radiant project, a directory (<project_directory>) to store the
project files, and a top-level design implementation name (<top_level_instance_name>). Click Next two times.

New Project X
Project Name

Enter a name for your project and specify  directory where the project data files will be stored.

Project:

Name: | project name

Location: | project_directory - Browse...

Project will be created at project_directory/project_name [ create subdirectory

Implementation:

Name: top_level_instance_name|

Location: | project_directory/project_name/top_level_instance_name

< Back MNext > Cancel Help

Figure 7.2. New Project Settings
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3. Under Family, select Avant or Certus-N2. Under Device, Package, Operating Condition, and Performance Grade,
make the appropriate selections representative of the selected device part number. Click Next.

Mew Project

Select Device

Specify a target device for the project.

Select Device: Device Information:

Family: Device: Care Voltage: 082V
iCEAO0UP (iCE40 UltraPlus) | LAV-AT-E70 System LCs: 637000
LAV-AT {Avant) LAV-AT-E70B LUTs: 397440
LFCPNEX (CertusPro-NX) LAV-AT-E70ES1 Registers: 397440
LFD2NX (Certus-NX) LAV-AT-G50 . o
LFMXOS (MachX05-NX) |\ o o
LIFCL (CrossLink-NX) LA _AT-T0ES DDRPHY: 3
LN2-CT (Certus-N2) - DSPs: 1800
LN2-MH (Mach-N2) LAY-AT-X50 Plis 1
UT24C (Certus-NX-RT) LAV-AT-X70 s &
UT24CP (CertusPro-MX-... | | LAV-AT-X70ES

PCSs: 0
4 QK] PIO Cells: 557

Operating Condition: Package: PIO Pins: 557
Commercial ¥ | | LFG1156

Performance Grade:

3
Part Mumber:
LAV-AT-E70ES1-3LFG1156C
Online Data Sheet for Device
< Back Next > Cancel Help

Figure 7.3. Project Device Settings

4. Specify the desired synthesis tool for implementation of the Lattice Radiant project. Click Next and Finish.

Mew Project

Select Synthesis Tool

Specify a synthesis tool for the implementation.

Synthesis Tools:
® Synplify Pro
Lattice LSE

< Back Mext >

Cancel Help

Figure 7.4. Project Synthesis Tool Selection
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7.1.2. Configuring and Generating the IP
The following steps shows how to generate the DDR Memory PHY IP Core in Lattice Radiant software.

1. Under the IP Catalog (Tools > IP Catalog), locate and double-click on the desired DDRPHY IP listed under Module >
Architecture_Modules > 10.

2. The Module/IP Block Wizard dialog box will open. Provide a name (<instance_name>) and directory
(<instance_directory>) for the DDRPHY IP, where the default directory is set to project_directory>/<project_name>.
Click Next.

Module/IP Block Wizard X

Generate Component from Module ddrphy Version 2.2.0
This wizard will guide you through the configuration, generation and instantiation of this Module/IP. Enter
the following information to get started.

Component name: | instance_name

Create in: C:/Work/project_directory/project_name Browse...

his will automatically create a folder for instance_name inside the C:/Work/project_directory/project_name

MNext > Cancel

Figure 7.5. IP Instance Settings

3. The DDRPHY IP editor contains multiple tabs that need to be configured according to the desired DDR4/LPDDR4
memory interface implementation. For detailed information on the individual attributes, refer to the IP Parameter
Description section of this user guide.

4. Click Generate. The Check Generating Result dialog box opens, showing design block messages and results as
shown in Figure 7.6. Click Finish.

Module/IP Block Wizard x

Check Generated Result
Check the generated component results in the panel below. Uncheck option ‘Insert to
project! if you do not want to add this component to your design.

Compenent ‘instance_name' is successfully generated.
Madule: ddrphy  Version: 220

Vendor: latticesemi.com

Language: Verilog

Generated files:

IP-XACT_component: componentaxml

IP-XACT _design: design.xml
black_box_verilog: rilfinstance_name_bb.v

cfg: instance_name.cfg

dependency_file: eval/dut_instv
dependency_file: eval/dut_params.v

IP package file: instance_name.ipx
tel_constraints: constraints/instance_name
template_verilog: misc/instance_name_tmplyv
dependency_file: testbench/dut_instv
dependency_file: testbench/dut_params.v
timing_constraints: constraints/instance_name.ldc
template_vhdl: misc/instance_name_tmpl.vhd
top_level_system_verilog: rtl/instance_name.sv

B insert to project

< Back CFinish

Figure 7.6. IP Generation Result

5. All the generated files are placed under the <instance_directory>/<instance_name> directory path. The generated
files in this directory <instance_directory>/<instance_name> are listed in Table 7.1. Generated File List

© 2023-2025 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
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File Name

Description

component.xml

Contains the ipxact_component information of the IP.

design.xml

Lists the set parameters of the IP in IP-XACT 2014 format.

<instance_name>.cfg

Lists only the configured/changed parameter values set during IP configuration.

<instance_name>.ipx

Lists the files associated with IP generation.

constraints/<instance_name>.ldc

Defines the 1/0 standard for LPDDR4 memory interface signals.

eval/apb2init.sv

Implements handshaking between APB accesses and internal RISC-V CPU for initialization
of DDR4/LPDDR4 memory in DDR Memory PHY Module Example Design.

eval/clock_constraint.sdc

Pre-synthesis constraint for setting the PLL reference clock frequency of the DDR
Memory PHY Module Example Design.

eval/constraint.pdc

Post-synthesis constraints for the DDRPHY Example Design.

eval/dut_inst.v

Instantiation of generated IP core in eval_top.sv for DDR Memory PHY Module Example
Design.

eval/dut_params.v

Defines local parameters for eval_top based on parameter values set during IP
configuration for DDR Memory PHY Module Example Design.

eval/eval_top.sv

Top-level RTL file for the DDR Memory PHY Module Example Design.

eval/kitcar.v

Counter that drives LEDs to indicate that internal clocks (pclk and aclk) are active in DDR
Memory PHY Module Example Design.

eval/pll_aclk_pclk.v

PLL responsible for generating APB clock (pclk) and AXI4 (aclk) in DDR Memory PHY
Module Example Design.

eval/select_protocol.py

Script that defines LPDDR4 protocol for eval_top and tb_top files in DDR Memory PHY
Module Example Design.

eval/axi_bridge/

Contains RTL for AXI bus interface to Native I/F.

eval/traffic_gen/

Contains RTL files for the DDRPHY Example Design.

misc/<instance_name>_tmpl.v
misc/<instance_name>_tmpl.vhd

These files provide instance templates for the IP core.

rtl/<instance_name>.sv

Example RTL top-level file that instantiates the IP core.

rtl/<instance_name>_bb.v

Example synthesizable RTL black box file that instantiates the IP core.

testbench/debug_c_code.sv

For internal use only.

testbench/dut_inst.v

Template instance files.

testbench/dut_params.v

List of parameters based on user IP configurations.

testbench/tb_top.sv

Top level testbench file.

testbench/Ipddra/

Contains DDR4/LPDDR4 memory model and instances for simulation.

7.2. Design Implementation

A memory controller is required to run the DDR Memory PHY Module Example Design on hardware. For hardware
evaluation, please refer to the DDR Memory Controller IP and DDR Memory Controller IP User Guide (FPGA-IPUG-

02208).

7.2.1. Pin Placement

In the Lattice Avant and Lattice Nexus 2 FPGA devices, external memory interfaces are supported in the DDRPHY, which
is composed of three High Performance I/O (HPIO) banks. These banks are labeled as HIGHSPEED in the device pinout
tables. Since Avant and Nexus 2 leverage a hardened PHY, the external memory interface pinouts are in fixed locations,
where each pin location is specified under DDRPHY in the device pinout tables. Dedicated clock routing within HPIO
banks is represented as PLL or PCLK, and dedicated reference voltage pins are represented as VREF, in the device
pinout tables. For more information refer to the High-Speed I/0O User Guide and Pinout files located on the Avant-
E/G/X and Certus-N2 web pages at www.latticesemi.com.
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Observe the following guidelines when placing pins for external memory interfaces:
e Ensure that pins for external memory interfaces reside within a DDRPHY.

e Theinput reference clock to the PLL must be assigned to use dedicated clock routing (GPLL). It is recommended to
place the input reference clock on a dedicated PLL pin (GPLL) within the HPIO bank to improve performance and
minimize jitter and routing.

Always test proposed pinouts in Lattice Radiant software with correct I/O standards before finalizing. Note that unused
pins within a DDRPHY can be used as general-purpose |I/O under certain conditions. Refer to the Lattice Avant High-
Speed I/0 and External Memory Interface User Guide (FPGA-TN-02300) more details.

7.2.2. Constraints

To ensure proper design coverage and hardware functionality, you must include the necessary constraints from
Table 7.2 in their DDRPHY IP project.

Table 7.2. Project Constraints

File Name Description Action Required
DDRPHY IP LDC file: Sets the 1/0 type for each of the ports No — these constraints are automatically
constraints.sdc/<instance_name>.ldc necessary to interface with propagated
’ - ’ DDR4/LPDDR4 SDRAM. ’
Yes — user needs to include a create_clock
Clock Constraint SDC file: Contains an example constraint for the constraint based on the frequency for the
eval/clock_constraint.sdc input PLL reference clock. input PLL reference clock. This can be placed
in a user-created SDC or PDC file.
. . . . Yes — user needs to copy example design
Example Design PDC file: Contains generated constraints based ! . Py examp '8
; > . constraints to run the DDRPHY Example
eval/constraint.pdc on IP configuration. Design

7.2.2.1. Reference Clock SDC

The provided clock_constraint.sdc file contains a single create_clock constraint for the PLL reference clock (pll_refclk_i).
This constraint is necessary for the PLL to generate the constraint for its output clock. You should copy this constraint
into the Radiant Project SDC file (not in PDC file) to allow the synthesis tool to optimize the logic for the target clock.

7.2.2.2. Example Design PDC
The provided constraint.pdc file contains eval constraints — specific to the DDRPHY Example Design.

The eval constraints include set_false_path, set_max_delay, and Idc_create_group constraints and should only be
copied if running the provided DDRPHY Example Design. Refer to the Lattice Radiant Timing Constraints Methodology
User Guide for details regarding the implementation of constraints.

7.3. Example Design Simulation

After configuring and generating the DDRPHY IP Core, you can use the included example design to simulate the
DDR4/LPDDR4 memory interface. All associated simulation files are located in the testbench directory. Refer to

Table 7.2 for more details.
The following steps illustrate how to prepare the DDRPHY Example Design project for simulation.

1. After generating the DDR Memory PHY IP Core, the Radiant project should include the <instance_name>.ipx under
the project’s input files. If it is not included, right-click on Input Files and select Add > Existing File under the File
List tab in the lower-left corner of the Radiant window. This action opens an Add Existing File dialog box. Navigate
to the <instance_directory>/<instance_name> directory and select the <instance_name>.ipx file. Ensure the Copy
file to directory option is unchecked. Click Add.

2. To add the top-level example design file to the project, right-click on Input Files and select Add > Existing File. This
action opens an Add Existing File dialog box. Navigate to the eval directory and select the eval_top.sv file. Ensure
the Copy file to directory option is unchecked. Click Add.
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Add Existing File ? X
Look in: C:\project_directory'project_name\jnstance_name - Q@ ) © Ilﬁ @ E]
h My Computer MName - Size Type Date Modified
2 dabdulra constraints Fil...der 5/23/2...:47 PM
L)
eval Fil..der 6/19/2..:36 PM
misc Fil...der 6/19/2...:56 PM
rtl Fil..der &/19/2...:56 PM
testbench Fil..der 6/19/2...:36 PM
[ instance_name.ipx 545KiB ipx File 6/19/2..:56 PM
File name:
Files of type: | Input Files (*.vhd *.v *.sv *.h *.ipx *.shx *.vm *.ipm )} - Cancel
Copy file to directory | C:/project_directory/project_name fsourcetop_level_instance_name

Figure 7.7. Add Existing File Dialog Box

3. To add the top-level testbench file to the project, select File > Add > Existing Simulation File. This action opens an
Add Existing Simulation File dialog box. Navigate to the testbench directory and select the tb_top.sv file. In the
Add Existing File dialog box, ensure the Copy file to directory option is unchecked. Click Add.

4. Before creating the simulation environment, set the SIM parameter in eval_top.sv to 1. This parameter shortens
the initialization sequence of the DDR4/LPDDR4 interface.

When SIM is set to 1, it programs 0x01C to the Training Operation Register (TRN_OP_REG) to speed up the simulation

runtime by reducing the reset and CKE initialization time. You can configure the simulation of reset, initialization, and

training sequences by forcing the value of TRN_OP_REG, as indicated by locating the following comment in tb_top.sv:

// This force shortens the initialization, vref trainings are also skipped

// force
tb_top.u_eval_top.u_lpdmc_0.1lscc_lpddr4_mc_inst.u_trn_eng.i_csr.trn_operation_reg =
10'he1C;

It is also recommended to skip the training sequences by writing 10’h01C to TRN_OP_REG/trn_opr_i. This action
reduces simulation time by programming the verified trained values to the PHY.

www.latticesemi.com/legal


http://www.latticesemi.com/legal

DDR Memory PHY Module R LATTICE
User Guide

To create the simulation environment for the DDR Memory PHY Module Example Design, the follow these steps:

1. Launch the simulation wizard in Radiant by selecting Tools > Simulation Wizard. This action opens the Simulation
Wizard dialog box. Click Next and provide a name (<sim_name>) and directory (<sim_directory>) for the simulation
project. The default directory is set to <project_directory>/<project_name>. Click Next.

Simulation Wizard X

Simulator Project Name and Stage
Enter name and directory for your simulation project. Choose simulator and the process
stage you wish to simulate. Available stages are automatically displayed.

Project

Project name: sim_name

Project location: = sim_directory Browse..
Simulator

@ QuestaSim

QuestaSim Qrun
ﬂ Invoke

Process Stage
@ RTL

< Back Next > Cancel

Figure 7.8. Simulation Wizard

2. Inthe Add and Reorder Source window, note that the Source Files only contain the top-level evaluation
(eval_top.sv) and top-level testbench (tb_top.sv) files. Click Next.

Simulation Wizard X

Add and Reorder Source
Add HDL type source files and place test bench files under the design files.

. @
Source Files: e lo

C:/Iscc/radiant/2024.2/bin/nt64/project_directory/project_name/instance_name/rtl/instance_name.sv
Ciflscc/radiant/2024.2 /bin/nt64/project_directory/project_name/instance_name/testbench/tb_top.sv
Ciflscc/radiant/2024.2 /bin/nt64/project_directory/project_name/instance_name/eval/eval_top.sv

u Automatically set simulation compilation file order.

Uncheck this if you want to follow the file order from "Input Files” on File List.

< Back Next > Cancel

Figure 7.9. Adding and Reordering Simulation Source Files
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3.

In the Parse HDL files for simulation window, note that the Simulation Top Module is set to tb_top. Click Next.

Simulation Wizard X

Parse HDL files for simulation
Parse HDL files for simulation.

Simulation top parsing finished.

-

-- Analyzing VHDL file 'C:/Iscc/radiant/2024.2/ispfpga/vhdl_packages/syn_unsi.vhd’ (VHDL-1481)
-- Analyzing VHDL file C:/Iscc/radiant/2024.2/ispfpga/vhdl_packages/syn_unsi.vhd

-- Analyzing VHDL file 'C:/Iscc/radiant/2024.2/ispfpga/vhdl_packages/synattr.vhd' (VHDL-1481)

- Analyzing VHDL file C:/Iscc/radiant/2024.2/ispfpga/vhd|_packages/synattr.vhd

- Analyzing Verilog file 'C:/Iscc/radiant/2024.2/cae_library/synthesis/verilog/lav-ate.v' (VERI-1482)
- Analyzing VHDL file 'C:/Iscc/radiant/2024.2/cae_library/synthesis/vhd|/lav-ate.vhd® (VHDL-1481)
- Analyzing VHDL file Ci/Iscc/radiant/2024.2/cae_library/synthesis/vhdl/lav-ate.vhd

-- Analyzing Verilog file 'C:/Iscc/radiant/2024.2/bin/nt64/project_directory/project_name/
instance_name/rtl/instance_name.sv' (VERI-1482)

-- Analyzing Verilog file 'C:/Iscc/radiant/2024.2/bin/nt64/project_directory/project_name/
instance_name/testbench/tb_top.sv' (VERI-1482)

-- Analyzing Verilog file 'C:/Iscc/radiant/2024.2/bin/nt64/project_directory/project_name/
instance_name/eval/eval_top.sv' (VERI-1482)

Hdl files parsing messages are saved at: C:/Iscc/radiant/2024.2/bin/nt64/project_directory/

project_name/sim_name/hdlparser.log =
Simulation Top Module:  tb_top A
< Back Next > Cancel

Figure 7.10. Parsing Simulation HDL Files

The following error message is expected during the parsing of the HDL files using the Simulation Wizard. This message
is due to the DDR4 simulation model being encrypted. They will not affect the simulation behavior since Questasim can
decrypt the DDR4 memory model:

ERROR <1009990> - key keyowners are not support. Must have “Lattice Semiconductor”.

4.

This action opens the Summary window. By default, the simulation will run for 100 ns, allowing you to configure
the waveform to log signals of interest in the Questasim simulator before continuing. You can then enter the
following TCL command in Questasim to run the simulation until completion: run -all. Alternatively, if you wish to
run the simulation with the default top-level signals, you can change the 100 ns value to 0 pus to execute the

simulation completely.

Simulation Wizard

Summary

Simulator : QuestaSim Qrun

Project Name : sim_name

Project Location : Ci/lscc/radiant/2024.2/bin/nte4/project_directory/project_name

Simulation Stage : RTL

Simulation Files :
Ci/lscc/radiant/2024.2 /bin/nté4/project_directory/project_name/instance_name/rtl/instance_name.
C:/Iscc/radiant/2024.2/bin/nté4/project_directory/project_name/instance_name/testbench/tb_top.
C:/lscc/radiant/2024.2 /bin/nt64/project_directory/project_name/instance_name/eval/eval_top.sv

Cmmlatictibric. ;
ﬂ Launch Simulator GUI
V] Design Optimization - Full Debug E Add top-level signals to waveform display
Run simulation
Default Run 100.000 | ns + (0 means ‘run -all’)

Simulator Resolution | default

< Back Finish Cancel

Figure 7.11. Simulation Summary
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The results of the DDRPHY simulation design are shown in Figure 7.12.

SR~ E-X- REFRE] -Se Ry e |(S2aam [ECEINECH f| t@t| L 8| B2

531342640816 s 1o 531398886

Figure 7.12. Simulation Result Waveform

The Questasim simulation log expects the following error messages and disregard them. These messages violate the
timing requirements of the LPDDR4 simulation model due to the shortened reset and CKE initialization

# tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected> 26083125000 : ### lpddrd_debug
RESET_n high input

# tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected> 26083125000 : ### 1pddr4_debug
RESET_n high input

# Error: tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected>.<protected> 26083125000 tINIT1
Error.

# Error: tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected>.<protected> 26083125000 tINIT1
Error.

# tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected> 32804075000 : ### 1pddr4_debug CKE
high input

# tb_top.LP4MEM_01.mem_x16_01.ins_1ch.<protected> 32804075000 : ### 1pddr4_debug CKE
high input

# Error: tb_top.LP4MEM_©01.mem_x16_01.ins_1ch.<protected>.<protected> 32804075000 tINIT3
Error.

# Error: tb_top.LP4MEM_00.mem_x16_00.ins_1ch.<protected>.<protected> 32804075000 +tINIT3
Error.
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Table A.1 and Table A.2 display the configuration and resource utilization for IP Core v2.3.0 implemented for
LAV-AT-X70 using Synplify Pro of Lattice Radiant software 2024.2.1.

Table A.1. DDR4 Resource Utilization for IP Core v2.3.0

Configuration

sclk_o Fmax!
(MHz)

Registers

LUTs

EBR DSP

Interface Type = DDR4,
DDR Bus Width = 16,
Clock Frequency = 1200,
Others = Default

300

1,495

2,044

16 0

Interface Type = DDR4,
DDR Bus Width = 32,
Clock Frequency = 1200,
Others = Default

300

1,495

2,045

16 0

Interface Type = DDR4,
DDR Bus Width = 64,
Clock Frequency = 1200,
Others = Default

300

1,495

2,064

16 0

Interface Type = DDR4,

DDR Bus Width =40,

Side Band ECC Enable = Checked,
Clock Frequency = 1200,

Others = Default

300

1,495

2,043

16 0

Interface Type = DDR4,

DDR Bus Width =72,

Side Band ECC Enable = Checked,
Clock Frequency = 1200,

Others = Default

300

1,495

2,074

16 0

Note:

1.

Table A.2. LPDDR4 Resource Utilization for IP Core v2.3.0

The sclk_o Fmax is generated using the top-level example design wrapper file, eval_top.sv, that is described in the Synthesis

Example Design section of this User Guide. These values may increase when the IP Core is used with the user logic.

. . sclk_o Fmax! .
Configuration (MHz) Registers LUTs EBR DSP
Interface Type = LPDDR4,
DDR Bus Width = 16,
300 1,515 2,046 16 0
Clock Frequency = 1200,
Others = Default
Default 300 1,515 2,041 16 0
Interface Type = LPDDR4,
DDR Bus Width = 64,
300 1,515 2,032 16 0
Clock Frequency = 1200,
Others = Default

Note:

1.

The sclk_o Fmax is generated using the top-level example design wrapper file, eval_top.sv, that is described in the Synthesis

Example Design section of this User Guide. These values may increase when the IP Core is used with the user logic.
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e DDR Memory PHY IP Release Notes (FPGA-RN-02072)

e Lattice Radiant Timing Constraints Methodology User Guide (FPGA-AN-02059)

e Debugging with Reveal Usage Guidelines and Tips Application Note (FPGA-AN-02060)

e Lattice Avant High-Speed 1/0 and External Memory Interface User Guide (FPGA-TN-02300)
e Avant-E web page

e Avant-G web page

e Avant-X web page

e  Certus-N2 web page

e Lattice Radiant FPGA design software

e AMBA APB Protocol Specification

e DFI 4.0 Specification

e DDRA4 JEDEC Standard

e |LPDDR4 JEDEC Standard

e Lattice Sales Office for more information about pricing and availability of the DDRPHY IP
e Lattice Insights for Lattice Semiconductor training courses and learning plans
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Technical Support Assistance

Submit a technical support case through www.latticesemi.com/techsupport.

For frequently asked questions, please refer to the Lattice Answer Database at
www.latticesemi.com/Support/AnswerDatabase.
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Revision History

Revision 1.3, IP v2.4.0, June 2025

Section Change Summary
All e Minor editorial fixes.
e  Updated IP version from 2.3.0 to 2.4.0.
Introduction e  Updated Supported Devices and removed Target Devices in Table 1.1.

e  Updated DDR4 Features:
e x8 and x16 DDR4 device support (8:1 DQ:DQS ratio)
e Configurable CAS latencies for Reads and Writes based on target interface speed
e  Supports component (DRAM soldered on the board) and UDIMM.
e Added CS Training, updated Bit-Level Trim Sweep and Data Bus Inversion in Table 1.2.
e Updated Automatic VREF Training to Not yet supported in Table 1.2.

IP Parameter Description e  Removed Enable DBI, and updated Read Latency and Write Latency in Table 3.1.

e  Updated I/0 Buffer Type, Read Latency and Write Latency description in Table 3.4.
e Updated DDR4 training settings in Table 3.5.

e Added DDR4 training settings: Table 3.6 and Table 3.7.

e  Updated DDR4 training settings description in Table 3.8.

e Change parameter name from Enable DBI to Enable Read DBI in Table 3.9.

e  Updated LPDDRA4 training settings in Table 3.13.

e  Added LPDDR4 training settings: Table 3.14 and Table 3.15.

e  Updated LPDDRA4 training settings description in Table 3.16.

Signal Description e Updated descriptions of pll_refclk_i, pclk_i, rst_i in Table 4.1.
e Added note 2 in Table 4.5.
Register Description e  Updated description for INIT_CTRL_REG and added Vref registers in Table 5.1.

e  Removed phy_reset in Reset Register section.

e  Removed Initialization Control Register section.

e  Modified Mode Register Write Control Register section.

e  Added CS delay in Clock/Address/Control Trim Register section.
e Added DDR4 mode in ODT Settings Register section.

e Added Vref setting sections: DRAM VREF Register,
PHY VREF Register for DQS Groups 0-3, PHY VREF Register for DQS Groups, and
PHY VREF Register for DQS Group 8.

Revision 1.2, IP v2.3.0, March 2025

Section Change Summary
All e  Changed the document title from DDR Memory PHY Module for Avant Devices to DDR
Memory PHY Module.

e  Reworked document content and structure for clarity.
e  Removed DDR3L support.
e  Added /P version 2.3.0 in the cover page.

Abbreviations in This Document e  Replaced Acronyms with Abbreviations.
e  Reworked section contents.

Introduction e  Reworked section contents.

e  Added IP Validation Summary, Licensing and Ordering Information, and Minimum
Device Requirements subsections.

e  Reworked 1.3 Conventions section and renamed to subsection 1.6 Naming Conventions.
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Section

Change Summary

Functional Description

e  Reworked subsection 2.1. Overview and renamed to subsection 2.1 IP Architecture.

e  Added Clocking, Reset and User Interfaces subsections.

e Reworked subsection 2.5. Initialization and Training and renamed to subsection 2.5
Calibration.

e Reworked subsection 2.2.1 DFI Signals Consideration and moved under subsection
2.6 Operations Descriptions.

IP Parameter Description

Reworked subsection 2.3 Attributes Summary and moved this under the IP Parameter
Description section.

Signal Description

Reworked subsection 2.2 Signal Description and converted it to Signal Description section.

Register Description

Reworked subsection 2.4 Register Description and converted it to Register Description
section.

DDRPHY Example Design

Added this section.

Designing and Simulating the IP

Reworked the IP Generation, Simulation, and Validation section and converted it to
Designing and Simulating the IP section.

Appendix A. Resource Utilization

Reworked section contents.

References

Reworked section contents.

Revision 1.1, December 2023

Section

Change Summary

Disclaimers

Updated disclaimers.

Inclusive Language

Added inclusive language boilerplate.

Acronyms in This Document

Added acronyms definition.

Introduction

e  Added supported interfaces for DDR4 and DDR3L in the Introduction section.
e  Added support for LAV-AT-G70 and LAV-AT-X70 devices in Table 1.1 Quick Facts.

e  Updated supported frequencies, DDR widths, and training and initialization support in
the Features section.

Functional Description

e  Updated the Overview section.
e  Updated the following tables:
e Table 2.1. DDR Memory PHY Module Signal Description
e Table 2.2. Attribute Table
e  Table 2.3. Attribute Description
e  Table 2.4. Summary of DDRPHY Module Registers
e  Updated the following registers in the Registers Description section:
e  Feature Control Register (FEATURE_CTRL_REG)
e  Reset Register (RESET_REG)
e  PHY Clock Register (PHY_CLOCK_REG)
e Interrupt Status Register (INT_STATUS_REG)
e Interrupt Enable Register (INT_ENABLE_REG)
e Interrupt Set Register (INT_SET_REG)
e Initialization Control Register (INIT_CTRL_REG)
e  Training Operation Register (TRN_OP_REG)
e  Training Status Register (TRN_STATUS_REG)
e  Added the following registers in the Register Description section:
e  Time Out Register (TIMEOUT_REG)
e  Time Reload Register (TIMER_RELOAD_REG)
e  Mode Register Write Control Register (MRW_CTRL_REG)
e Trim Settings 1 Register (TRIM_SETTINGS_1_REG)
e  ODT Settings Register (ODT_SETTINGS_REG)
e Updated the Initialization and Training section.
e  Added the Bit-Level Trimp Sweep section.
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Section

Change Summary

IP Generation, Simulation, and
Validation

e  Updated Figure 3.1, Figure 3.2, Figure 3.3, and Table 3.1 in the Configuring and
Generating the IP section.

e Updated Running Functional Simulation section.

e Added a reference to the Lattice Radiant Timing Constraints Methodology in the
Constraining the IP section.

Resource Utilization

Updated the Resources Utilization section.

References

Added references.

Technical Support Assistance

Added link to the Lattice Answer Database.

Revision 1.0, November 2022

Section

Change Summary

Introduction

. Updated device name, software version and resource utilization in Table 1.1.

e  Updated Features section to add DDR4 Support and Self-Calibrating Logic, and updated
the supported frequencies and DDR data widths.

Functional Description

e  Updated Table 2.1 to add DDR4-specific signals

e  Updated Table 2.2 and Table 2.3 to add DDR4-related attributes.

e  Updated Table 2.4 with additional registers

e  Updated ddr_type and addr_translation fields of Feature Control Register section.

e Added pll_ref_clk field in PHY Clock Register section.

e  Added ddr_ck_dis and updated dfi_cke in Initialization Control Register section.

e Added mem_verf_training_en and mc_vref_training_en in Training Operation Register
section.

e  Added Scratch Registers in Table 2.4 and added section 2.4.15 for these registers.
e  Removed Read Gate Leveling section and added Self-Calibrating Logic section.

IP Generation, Simulation, and
Validation

e  Updated section name.

e  Updated Figure 3.1, Figure 3.2, and Figure 3.3 in Configuring and Generating the IP
section.

e Updated Running Functional Simulation section.

e Added Constraining the IP section.

Appendix A. Resource Utilization

Added Resource Utilization section.

References

Added web page references of Avant and JEDEC.

Revision 0.8, May 2022

Section

Change Summary

All

Preliminary Release
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